This Documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by CA at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Documentation is confidential and proprietary information of CA and may not be disclosed by you or used for any purpose other than as may be permitted in (i) a separate agreement between you and CA governing your use of the CA software to which the Documentation relates; or (ii) a separate confidentiality agreement between you and CA.

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all CA copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is CA.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

Copyright © 2012 CA. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
Contact CA Technologies

Contact CA Support

For your convenience, CA Technologies provides one site where you can access the information that you need for your Home Office, Small Business, and Enterprise CA Technologies products. At [http://ca.com/support](http://ca.com/support), you can access the following resources:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- CA Support policies and guidelines
- Other helpful resources appropriate for your product

Providing Feedback About Product Documentation

If you have comments or questions about CA Technologies product documentation, you can send a message to techpubs@ca.com.

To provide feedback about CA Technologies product documentation, complete our short customer survey which is available on the CA Support website at [http://ca.com/docs](http://ca.com/docs).
## Contents

### Chapter 1: Introduction
- About this Guide .................................................................................................................. 7
- Legal Notices .......................................................................................................................... 7
- Audience .................................................................................................................................. 7

### Chapter 2: Financial Administrator Scenarios
- How to Create a Budget Revision ......................................................................................... 9
  - Review the Prerequisites ....................................................................................................... 11
  - Add Line Items to the Budget .............................................................................................. 12
  - Change Time Period Values in the Budget .......................................................................... 13
  - Delete Line Items from the Budget ..................................................................................... 15
  - Replace the Budget with a New Cost Plan .......................................................................... 16
  - Verify the Revised Budget Plan .......................................................................................... 17

### Chapter 3: System Administrator Scenarios
- How to Configure the Views for an Object .......................................................................... 19
  - Review the Prerequisites ..................................................................................................... 22
  - Configure the Properties View ........................................................................................... 23
  - Configure the List View ....................................................................................................... 28
  - Configure the Filter View .................................................................................................... 38
  - Display and Verify Custom Object Views .......................................................................... 39
- How to Create a Custom Object ..............................................................................................
  - Review the Prerequisites ..................................................................................................... 42
  - Create an Object .................................................................................................................. 45
  - Create Attributes ............................................................................................................... 45
  - Add Attributes to the Object Properties View ................................................................... 63
  - Add Attributes to the Object List Filter View .................................................................... 63
  - Add Attributes to the Object List Column View ............................................................... 64
  - Grant Access to the Object ................................................................................................. 65
  - Add a Menu Page Link for the Object ................................................................................. 65
- How to Create a Portlet Page ...................................................................................................
  - Plan the Portlet Page ........................................................................................................... 67
  - Create the Portlet Page ........................................................................................................ 69
  - Set Up Link Parameters for the Portlet Page ....................................................................... 70
  - Assign User Access to the Portlets ...................................................................................... 77
  - Assign User Access to the Portlet Page ................................................................................ 78
Add Portlet Page to Menu Manager and Verify .............................................................................. 79
How to Create a User Group .............................................................................................................. 80
  Review the Prerequisites .................................................................................................................. 81
  Create a User Group ....................................................................................................................... 81
  Add Users to a User Group ............................................................................................................. 81
  Assign Access Rights to a User Group ............................................................................................ 82
How to Customize the Actions Menu .................................................................................................. 85
  Review the Prerequisites .................................................................................................................. 87
  Create a Report Option ................................................................................................................... 87
  Create a Job Option ........................................................................................................................ 89
  Create a Process Option .................................................................................................................. 90
  Create an Internal Link Option ....................................................................................................... 91
  Create an External Link Option ....................................................................................................... 92
  Create a Submenu .......................................................................................................................... 93
  Update Existing Submenus ............................................................................................................ 94
  Test the Updates to the Actions Menu ............................................................................................ 95
How to Manage Authentication ........................................................................................................... 95
  Review the Prerequisites .................................................................................................................. 97
  Configure General Session Limits .................................................................................................. 97
  Configure General Password Options ............................................................................................. 98
  Manage User Login Status .............................................................................................................. 99
  Reset a User Password ................................................................................................................... 100
  Force a User to Reset a Password .................................................................................................. 101
  Force All Users to Reset Passwords ................................................................................................. 101
How to Set Up Partitions ..................................................................................................................... 102
  Plan the Implementation .................................................................................................................. 105
  Create a Partition Model and Add Partitions ................................................................................. 106
  Associate Objects with a Partition .................................................................................................. 107
  Include Attributes in a Partition ...................................................................................................... 107
  Modify Views for a Partition ............................................................................................................. 108
  Include Object Links in a Partition .................................................................................................. 109
  Define Static Lookup Values for a Partition .................................................................................... 109
  Select a UI Theme for a Partition .................................................................................................... 110
  Test the Partitions in the Product .................................................................................................... 110
  Assign User Access to Partitions ..................................................................................................... 111
Chapter 1: Introduction

Project and Portfolio Management solutions from CA Technologies allow you to innovate with agility, transform your portfolio with confidence, and sustain the right investments to manage business demands. With the most complete and proven project and portfolio management solution in the industry today, your team can be more productive with intuitive tools. Your management team and leaders have the transparency and visibility into the entire portfolio to ease decision making.

CA Clarity PPM is easy to use and configure, highly scalable, and value-added education and support services are available. On Demand, On Premise, and hosted options support your current and future needs.

This section contains the following topics:

*About this Guide* (see page 7)
*Legal Notices* (see page 7)
*Audience* (see page 7)

About this Guide

This guide describes some typical project and portfolio management scenarios and how CA Clarity PPM helps you resolve them. After you read this chapter, read each scenario that is appropriate for your role. You do not have to read all of the chapters in the presented order.

To help illustrate the scenarios, a fictitious company named Forward Inc. is used throughout this guide.

Legal Notices

Forward Inc. is a fictitious company name which use is strictly for instructional purposes only and is not meant to reference an existing company.

Audience

This guide is intended for all CA Clarity PPM roles, including:

- Financial Administrators
- System Administrators
Chapter 2: Financial Administrator Scenarios

This section contains the following topics:

How to Create a Budget Revision (see page 9)

How to Create a Budget Revision

An approved cost plan becomes the budget plan for an investment. Because elements of an investment change, you can revise various parts of the budget, or can replace the budget entirely.

You can make two types of revisions to an approved budget plan:

Merged Budget Plan Revision
- Submit a cost plan with new line items and merge the changes with the existing budget plan.
- Submit a portion of a cost plan by varying the start and end dates for the submission, or update the field values in specific time periods. You can submit only the changed time periods and can merge them with the budget.

Replacement Budget Plan Revision
- Submit a cost plan with deleted line items and replace the budget to remove those line items from the budget plan.
- Create a cost plan, using different grouping attributes or time period types, and replace the budget.

Both revision types provide approval history. However, the replace feature enables you to delete line items that are no longer needed, and to revise grouping attributes and fiscal time periods.

When you submit a cost plan that revises an existing budget, you specify whether to merge or replace using the Submit Options pull-down list. This field appears only when there is at least one approved budget. If the new cost plan has a different structure than the existing budget, Replace is the only option.

When your cost plan is approved, it becomes the revised budget plan with a new version number. You can view the previous version of the budget, which is saved separately. You cannot edit either previous budget plans or the current approved budget plans.
The following diagram describes how a financial administrator creates a budget revision.

**Example: Revise a Forward, Inc. Budget Plan**

The following example illustrates the options for updating the budget plan throughout this scenario. Forward Inc. has a new project that is planned for later this year. Alice manages the project and has already created a cost plan (ProjectA_estimatedCP-00) with the required roles and estimated costs.

She needs the following roles:
- One software architect
- Three Java software engineers
- Two test engineers
Alice has not yet staffed the project. In her submitted cost plan, she added roles for each of the positions and populated the cost plan for the six months of the project.

When creating the cost plan, Alice used the following properties for her cost plan:

- Grouping attributes: Role
- Time period type: Quarterly.
- Start and End Dates: July 2 - December 31

She submitted the estimates for approval as the current budget plan. Alice's product manager approved the estimated budget. The manager knows that the budget will change before the project begins.

Perform these steps to create a budget revision:

1. Review the prerequisites (see page 11).
2. Revise the budget plan:
   - Merge changes into the budget plan:
     - Add line items to the budget (see page 12).
     - Change time period values in the budget (see page 13)
   - Replace the budget plan:
     - Delete line items from the budget (see page 15)
     - Replace the budget with a new cost plan (see page 16)
3. Verify the revised budget plan (see page 17)

Review the Prerequisites

To complete all tasks in this scenario, consider the following information:

Access Rights

Have the following access rights:

- Financial - Cost Plan - Edit
- Financial - Financial Plan - Submit for Approval
- Project - Budget Plan - View
- Project - Budget Plan - Edit
Completed Tasks

Complete the following tasks before you begin the scenario:

- Create a cost plan for the investment.
- Specify the cost plan as the Plan of Record (POR).
- Submit the POR for approval and have it approved as the budget plan for the investment.

Other Information

After you submit a cost plan for approval, it becomes the submitted budget plan. You can edit the submitted budget plan; you cannot edit the budget plan after it is approved.

Add Line Items to the Budget

Add line items to the cost plan and merge the new lines into the budget. For example, you can add a role to a cost plan, and can submit the cost plan for approval as a merged change.

Example: Revise the Budget with a New Role

Alice determines that the new project needs a technical writer to document the online help. She adds the role of Senior Technical Writer to the cost plan, and submits the revised plan, ProjectA_estimatedCP-00, as a merged revision to the budget.

Follow these steps:

1. Open Home, and from Portfolio Management, click the appropriate investment type; for example, Projects.
2. Open the investment and click Financial Plans.
4. Open the cost plan.
5. Click Add to add the new line item.

   The Cost Plan Detail: Properties page appears and displays fields for each grouping attribute that appear in the cost plan. For example, if Role is a grouping attribute, then the Role field displays.

6. Select the values for the new line item (for example, roles) that you want to add.
7. Click Save and Return.
8. Enter the time period detail for the line item.

   Note: For more information about populating cost plans, see the Financial Management User Guide.
9. Save your changes and click Return.

10. Click Actions and select Set as Plan of Record.
    
    Note: If the cost plan is already the plan of record, skip this step.

11. Click Yes to confirm.

12. Click Actions and select Submit Plan of Record for Approval.
    
    Note: If you receive the following message, another cost plan for the investment exists as a submitted budget plan.
    
    Error: A submitted budget already exists.
    
    The submitted budget plan must be approved or rejected before you can submit another plan for approval.

13. Enter the requested values.

14. Select Merge in the Submit Option pull-down list.

15. Click Submit for Approval.

16. Open the Financial Plans menu and click Budget Plans to view the list of budget plans and their status.

You have submitted a cost plan for approval that merges an added line item into the existing budget.

**Change Time Period Values in the Budget**

You can revise the time period values in a cost plan and can merge them into the existing budget plan. Merging values from one or more time periods helps you keep the budget accurate, without having to replace the entire budget.

For example, you receive incremental funding for your budget to account for increases in resource costs. You can revise the cost of the resource for only the affected months.

If you have set a freeze date in the financial entity, you can only edit the cost plan for periods after the freeze date.

**Example: Append Time Periods to the Budget Plan**

Alice reviews the project plans with her manager and finds she needs to add three months for a new required feature. Alice revises her cost plan by adding three months to the project and populates fields with the cost information for each resource. She submits the revised cost plan, with the ID of ProjectA_estimatedCP-00, as a merged revision with only the additional months.
Follow these steps:

1. Open Home, and from Portfolio Management, click the appropriate investment type; for example, Projects.
2. Open the investment and click Financial Plans.
4. Open the cost plan.
5. Go to the correct time period for the plan in the Unit, Cost and Revenue Details section.
6. Edit the Units, Cost, and Revenue fields for the time period, as shown in the following graphic:

```
<table>
<thead>
<tr>
<th>Units</th>
<th>Cost</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.000</td>
<td>120.00 USD</td>
<td>200.00 USD</td>
</tr>
</tbody>
</table>
```

7. Save your changes and click Return.
8. Click Actions and select Set as Plan of Record.
   
   **Note:** If the cost plan is already the plan of record, skip this step.
9. Click Yes to confirm.
10. Click Actions and select Submit Plan of Record for Approval.
   
   **Note:** If you receive the following message, another cost plan for the investment exists as a submitted budget plan.
   
   Error: A submitted budget already exists.
   
   The submitted budget plan must be approved or rejected before you can submit another plan for approval.
11. Specify the Start Period and End Period values for only the months in which you are adding or updating the values.
12. Select Merge in the Submit Option drop-down list.
13. Click Submit for Approval.
14. Open the Financial Plans menu and click Budget Plans to view the list of budget plans and their status.

   You have submitted a cost plan for approval that merges revisions to time periods in the existing budget.
Delete Line Items from the Budget

Delete unnecessary line items and submit the cost plan as a replacement for the budget. For example, if you want to remove a line item from the budget plan, delete the line item in the cost plan. Submit the revised cost plan as a replacement for the budget plan.

**Note:** Select Replace to delete line items. Selecting Merge prevents the deletion and the line item remains in the submitted budget plan.

**Example: Delete a Role and Replace the Budget**

Several months before the project starts, Alice discovers that she must transfer the headcount of a test engineer to another project. She deletes the line item for the role for the junior test engineer from the cost plan, ProjectA_estimatedCP-00, and submits the plan for approval. Alice selects Replace to remove the line item from the budget.

**Follow these steps:**

1. Open Home, and from Portfolio Management, click the appropriate investment type; for example, Projects.
2. Open the investment and click Financial Plans.
4. Open the cost plan.
5. Select the line item that you want to delete and click Delete.
6. Click Yes to confirm and click Return.
7. Click Actions and select Set as Plan of Record.
   **Note:** If the cost plan is already the plan of record, skip this step.
8. Click Yes to confirm.
9. Click Actions and select Submit Plan of Record for Approval.
   **Note:** If you receive the following message, another cost plan for the investment exists as a submitted budget plan.
   
   Error: A submitted budget already exists.
   
   The submitted budget plan must be approved or rejected before you can submit another plan for approval.
10. Select Replace in the Submit Option pull-down list.
11. Click Submit for Approval.
12. Open the Financial Plans menu and click Budget Plans to view the list of budget plans and their status.

You have submitted a cost plan for approval that replaces the existing budget.
Replace the Budget with a New Cost Plan

Choose new grouping attributes and time period types for the budget by creating and submitting a new cost plan that replaces the approved budget plan.

For example, when planning for an upcoming project, you provide an estimated budget with the roles that you think you need. Before the start of the project, you create a cost plan with the actual resources and change the grouping attributes to include Department and Location. You can then submit the new cost plan to replace the approved budget plan.

Example: Submit a New Cost Plan and Replace the Budget

Alice fills all the positions for the team and knows the cost of each resource. She has resources in two locations and wants to group by department and location. Additionally, the product manager asks that she use monthly time periods instead of quarterly. Alice creates a cost plan and adds each resource with their cost details. She makes the following selections to the properties of the cost plan:

- Grouping Attributes: Location and Department
- Time period type: Monthly

Alice saves her changes as ProjectA_actualCP-00, and submits the new budget for approval.

Follow these steps:
1. Open Home, and from Portfolio Management, click the appropriate investment type; for example, Projects.
2. Open the investment and click Financial Plans.
4. Create a cost plan and populate it.
   
   **Note:** For more information about creating cost plans, see the Financial Management User Guide.
5. Click Save and click Return.
6. Click Actions and select Set as Plan of Record.
   
   **Note:** If the cost plan is already the plan of record, skip this step.
7. Click Yes to confirm.
8. Click Actions and select Submit Plan of Record for Approval.

    The Submit Option field lists Replace as the only available option. You must replace the budget when the grouping attributes or the fiscal time period type are different from those selected properties for the existing budget.

    **Note:** If you receive the following message, another cost plan for the investment exists as a submitted budget plan.

    Error: A submitted budget already exists.

    The submitted budget plan must be approved or rejected before you can submit another plan for approval.

9. Click Submit for Approval.

10. Open the Financial Plans menu and click Budget Plans to view the list of budget plans and their status.

    You have submitted a cost plan for approval that replaces the existing budget.

### Verify the Revised Budget Plan

After you submit the cost plan for approval, it becomes available as the submitted budget plan. You can view the status of the budget plan, as well as edit the plan if you have access rights.

**Example: Edit and Verify the Submitted Budget Plan**

Alice has submitted the revised cost plan for approval. The plan remains in the submitted budget plan state until her manager approves it. She verifies that her revisions have been merged into or have replaced the budget correctly. While Alice reviews the plan, she sees that the cost value for October is incorrect for one of the resources. She manually changes the value and saves her changes. Her manager approves the budget; and Alice has successfully revised the approved budget plan with her changes.

**Follow these steps:**

1. Open Home, and from Portfolio Management, click the appropriate investment type; for example, Projects.
2. Open the investment and click Financial Plans.
3. Open the Financial Plans menu and click Budget Plans.

4. Open the submitted budget plan to view the revisions and verify that the revisions are correct.

5. Edit values in the budget plan with any necessary revisions.

6. Save your changes and click Return.

   After you have verified that the submitted budget is correct and it has been approved, you have successfully revised the approved budget plan.
Chapter 3: System Administrator Scenarios

This section contains the following topics:

How to Configure the Views for an Object (see page 19)
How to Create a Custom Object (see page 40)
How to Create a Portlet Page (see page 67)
How to Create a User Group (see page 80)
How to Customize the Actions Menu (see page 85)
How to Manage Authentication (see page 95)
How to Set Up Partitions (see page 102)

How to Configure the Views for an Object

When you create a custom object in Studio, the following views appear for the object by default:

- Properties View. Displays and allows users to enter information about an object instance. The properties view controls the information that you see when you create an object instance or when you edit an existing instance.
- List View. Displays information about object instances in rows and columns.
- Filter View. Displays as a section that appears at the top of a list view and allows users to search for information.

Configure the default views to determine how object information displays on a page. You can also configure views for the objects that are available by default.
Example: Track Project Release Information in a Retrospective

Project Managers at Forward, Inc. provide a retrospective report to upper management at the end of a project release cycle. To assist with the report, the system administrator creates a custom object named Retrospective to allow project managers to capture the information for their projects. When project managers create an instance of a retrospective, they enter the following information in the fields that the Retrospective object provides:

- Project Name
- Project Start Date and End Date
- Project Manager
- Team Members
- What Went Well
- Areas for Improvement

Going forward, upper management wants to track the length of the release cycle in the retrospective. To meet this objective, the system administrator configures the properties view for the Retrospective object to include the following new attributes:

- Release Start Date
- Release End Date
The following diagram describes how a system administrator configures the views for an object.

How to Configure the Views for an Object

System Administrator

Review the Prerequisites

Configure the Properties View
- Add Attributes to the View
- Add Sections to the View
- Add a Subpage to the View

Configure the List View
- Setup Attributes and Options for the View
- Define Sorting Attributes for the View
- Display Graphics in the View
- Add Aggregation Rows to the View

Configure the Filter View

Display and Verify Custom Object Views

Create the Subpage
- Add Sections to a Subpage
- Define the Subpage Properties

Display an Attribute as a Bar or Column Chart
- Display a Progress Bar
- Configure Display Mappings
- Display a Gantt Chart
- Display an Image Link

View Configuration is Complete
Perform these steps to configure the views for an object:

1. **Review the Prerequisites** (see page 22).
2. **Configure the Properties View** (see page 23):
   - **Add Attributes to the View** (see page 23).
   - **Add Sections to the View** (see page 24).
   - **Add a Subpage to the View** (see page 25):
     - **Create the Subpage** (see page 25).
     - **Add Sections to a Subpage** (see page 26).
     - **Define the Subpage Properties** (see page 27).
3. **Configure the List View** (see page 28):
   - **Set Up Attributes and Options for the View**. (see page 28)
   - **Define Sorting Attributes for the View** (see page 29).
   - **Display Graphics in the View** (see page 30):
     - **Display an Attribute as a Bar or Column Chart** (see page 31).
     - **Display a Progress Bar**. (see page 32)
     - **Configure Display Mappings** (see page 33).
     - **Display a Gantt Chart**. (see page 34)
     - **Display an Image Link** (see page 36).
     - **Add Aggregation Rows to the View** (see page 37).
4. **Configure the Filter View** (see page 38).
5. **Display and Verify Custom Object Views** (see page 39).

### Review the Prerequisites

To complete all tasks in the scenario, consider the following items:

**Access Rights**

You need the following access rights:

- Administration – Studio
- Object – Create Definition
- Object Administration
In addition, you need global custom object rights to view and work with the object instances. For example, to work with the custom Retrospective object, you need the following access rights:

- Retrospective – Edit All
- Retrospective – Navigate
- Retrospective – View All
- Retrospective – XOG Access

**Assumptions**

This scenario assumes that you have created the attributes that you want to add to a view. The scenario does not explain how to create an attribute.

**Configure the Properties View**

The properties view for an object defines the following information for object instances:

- Which attributes display on the create or edit pages.
- The order and location in which attributes display on the page.

Configure the properties view to change which attributes display and how they display. For example, you can configure the properties view of the Retrospective object to include release-specific attributes. Including the release attributes allows users to provide release information for a project when creating a retrospective.

To configure the properties view, complete one or more of the following tasks:

- **Add Attributes to the View** (see page 24).
- **Add Sections to the View** (see page 24).
- **Add a Subpage to the View** (see page 25).

**Add Attributes to the View**

Configure the Properties view to add attributes to the create or edit pages of an object instance. For example, add release-specific attributes to the properties view of the Retrospective object to allow users to provide the release start and end date information.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
How to Configure the Views for an Object

4. In the Category column, locate the Properties view and click one of the following links from the Setup column in that row:
   - [Layout:Create]. Adds attributes to the properties page a user uses to create an instance initially for the object.
   - [Layout:Edit]. Adds attributes to the properties page a user uses to change the created instance of the object.

5. In the property layout, select the section to which you want to add the attribute, and click the Properties and Layout icon next to the item.

6. In the Available list, select the attributes that you want to add and move them into the correct Selected list box.

7. Save your changes.

Add Sections to the View

Configure the Properties view to add a section that lets you group certain attributes that appear on a page in meaningful ways. For example, all the organizational breakdown structure fields (Department, Location, and so on) can appear in a separate OBS section on the project properties page.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the Properties view and click one of the following links from the Setup column in that row:
   - [Layout:Create]. Adds sections to the properties page a user uses to create an instance initially for the object.
   - [Layout:Edit]. Adds sections to the properties page a user uses to change the created instance of the object.
5. In the property layout, click Create Sections.
6. Complete the following fields:
   - **Parent**
     Displays the name of the parent page for which you are creating sections.
   - **Section Names**
     Defines the section names for the page for a view.
7. Save your changes.
Add a Subpage to the View

Configure the Properties view to add a subpage to group specific information that can be displayed for the user on its own page. A subpage behaves like a page.

The Finance page for a project is an example of a subpage that groups all financial information for a project. The general Properties page stays generic and users can go to the Finance page to view or define any financial-specific data.

Verify that you have the following information to use the condition builder for a display condition for a subpage:

- The rules for manually entering an expression in the condition builder.
- The operands that allow you to create a display condition.

To add a subpage to the Properties view, complete the following steps in the recommended order:

1. [Create the subpage](see page 25).
2. [Optional]. [Add sections to the subpage](see page 26).
3. [Define the subpage properties](see page 27).

Create the Subpage

Create a subpage to group and present specific attributes for an object on its own page.

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the Properties view and click the [Layout:Edit] link from the Setup column in that row.
5. In the property layout, click Create Subpages and complete the required information. The following field requires explanation:

   **Subpage Name**
   
   Defines the linked name of the subpage that appears in an object menu. Users can select the link to navigate to the subpage.

   **Subpage ID**
   
   Defines the unique ID for the subpage. If you do not specify an ID, the system automatically assigns an ID to the subpage.
6. Click Save and Return.
Add Sections to a Subpage

You can optionally add sections to a subpage to group attributes in meaningful ways.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the Properties view and click the [Layout:Edit] link from the Setup column in that row.
5. In the property layout, click the name of the subpage to which you want to add sections.
6. Click Create Sections.
7. Complete the requested information. The following fields require explanation:
   - **Parent**
     Displays the name of the parent page for which you are creating sections.
   - **Section Names**
     Defines the section names for the subpage for a view. You can enter up to five section names at a time.
8. Click Save and Return.
9. To add attributes to the section, complete the following steps:
   a. Click the Properties and Layout icon next to the section.
   b. In the Available list, select the attributes that you want to add to the section.
   c. Move the attributes to the appropriate column and place them in the proper order in the column.
10. Save your changes.
Define the Subpage Properties

Define the subpage properties to determine the following factors:

- The layout of the subpage sections.
- The security to prevent unauthorized access.
- The conditions under which the subpage displays for users.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the Properties view and click the [Layout:Edit] link from the Setup column in that row:
5. In the property layout, click the Properties and Layout icon of the subpage.
6. Complete the requested information. The following fields require explanation:
   - **Sections**
     Defines the order in which the subpage sections appear on the subpage. Use the arrows to place the sections in the order that you want them.
   - **Current Location**
     Displays the path for the current subpage in relation to the parent page.
     Example: /Edit Project Properties/General
   - **Subpage Name**
     Defines the linked name of the subpage that appears in an object menu. Users can select the link to navigate to the subpage.
   - **Linkable**
     Specifies whether you can link to the subpage from other pages.
   - **Secure**
     Specifies whether the subpage has associated access rights. If you secure the subpage, access rights (view and edit) are generated for the subpage. Grant access rights to allow users to view or edit the subpage.

7. (Optional) In the Display Conditions section, click [Define display conditions] to define a set of conditions that determine when the subpage appears.
   
   Note: For more information about defining display conditions for subpages, see the Studio Developer's Guide.
8. Click Save and Return.
Configure the List View

The list view displays when you select an object link from the Home menu. The view lists all of the created instances of the object. For example, if you select Projects from the Home menu, the projects list page appears displaying all of the created project instances.

Configure the list view to change how the list page appears for your object instances.

The following rules apply when adding a lookup attribute to the list view of an object:

- Static dependent list lookups that are configured as multivalue lookups are not supported in list views.
- Autosuggest or the ability to populate fields automatically is not supported for static dependent lists.

To configure the list view, complete one or more of the following tasks:

- **Set Up Attributes and Options for the View** (see page 28).
- **Define Sorting Attributes for the View** (see page 29).
- **Display Graphics in the View** (see page 30).

Set Up Attributes and Options for the View

You can set up your list views in the following ways:

- Add attributes to display additional fields in the list. For example, configure the projects list view to include a Change Request field to display any associated change requests for any of the projects. You can also add virtual attributes (for example, progress bars, or Gantt charts) to display aggregations, comparisons, and variances.

- Define options for your lists such as how to display secondary values, filter results, and protect or display certain attributes. For example, if you have two fields named Cost and Baseline Cost, you can display both values in a cell. Select Baseline Cost as the secondary value. The Cost value displays as usual. When you move the cursor over a cell in the grid, the Baseline Cost also displays.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the desired List view and click the [Layout] link from the Setup column in that row.
   
   The list column layout page appears.
5. In the Available Columns list, select the attributes that you want to add and move them to the Selected Columns list.
6. Click Save and Return.
   The views list page appears.

7. In the Category column, locate the desired List view and click the [Options] link from the Setup column in that row.

8. Complete the requested information. The following fields require explanation:

   **Secondary Value Display**
   Indicates the way that secondary values display in a grid cell.
   **Values:**
   - Mouseover only. Displays no secondary value.
   - Mouseover and redline text. Displays a secondary, comparison value when you place the cursor over a cell in a grid.
   - Show Null Secondary Values. Displays the secondary value even when there is no number value to show.

   **Allow Configuration**
   Specifies whether users can change the appearance of the page.

   **Allow Label Configuration**
   Specifies whether users can change the page label. If you select the Allow Configuration option and clear the Allow Label Configuration option, users cannot configure labels but they can configure other items.

   **Attribute Value Protection**
   Indicates whether an attribute is protected or displayed. You can protect attributes from appearing using display conditions, secured subpages, or both.

9. Save your changes.

**Define Sorting Attributes for the View**

You can define up to four attributes (default, custom, or both) to sort a list view. For example, you can set up the project list page so that it sorts primarily by project name and then by project manager in alphabetical order.

**Follow these steps:**
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the List view and click the [Layout] link from the Setup column in that row.
How to Configure the Views for an Object

5. In the column layout, select an attribute to indicate the primary sort column in the First Field row of the Column Sorting section.

6. Indicate the direction of the sort by selecting Ascending or Descending.

7. Indicate additional sort columns by selecting attributes for the remaining fields in the Column Sorting section.

8. Save your changes.

Display Graphics in the View

You can use the following types of graphics to represent data in a list view:

- **Colors.** Represents data ranges by different colors where each color defines an attribute and a range of data. For example, you can configure an attribute so that the numbers 1-5 display in red, while the numbers 6-10 display in green.

- **Icons.** Represents ranges of values using a standard set of icons including colored checkmarks, discussion bubble, attachment icon, lock icon, and many others.

- **Bar or column charts.** Displays numbers, formulas, or money attributes as bar or column charts. Column charts are like bar charts, except that they are oriented up-and-down instead of left-to-right. You can add a stacked bar to bar charts that start at the right end of the primary bar. For example, add a stacked bar in the Primary Column to show cost to the date and another in the Secondary Column to show cost remaining.

The following rules apply when displaying graphics in list views:

- Virtual columns containing Gantt charts, progress bars, time sliced values, or virtual images cannot display graphics.

- Only number data type attributes can display graphics.

**Note:** Any changes that you make to the appearance of an attribute applies only to the specific view. You can set different appearance options for the same attribute in different views.

To display graphics in the list view, complete one or more of the following tasks:

- **Display an Attribute as a Bar or Column Chart** (see page 31).

- **Display a Progress Bar** (see page 32).

- **Display Values as a Color or Icon** (see page 33).

- **Display a Gantt Chart** (see page 34).

- **Display an Image Link** (see page 36).
Display an Attribute as a Bar or Column Chart

Display an attribute as a bar or column chart to represent the values of the attribute visually. Typically, number, formula, or money attributes work well with bar or column charts. For example, you can graphically display the Cost to Date attribute for a project instance.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the List view and click the [Fields] link in that row.
5. Click the Properties icon in the row that contains the attribute you want to change.
6. Complete the requested information depending on the attribute data and display type. The following fields require explanation:

   **Display Type**
   Specifies the type of chart to display for the attribute. The list of display type values is based on the attribute data type. For example, if the attribute data type is numeric, the display type values are Number, Percent, Calculated Percent, Column Graph, and Bar Graph.

   **Secondary Value**
   Defines the attribute whose value displays as a secondary value when the user moves a cursor over the primary bar.

   **Length Scaling**
   Defines the length scaling for the bars in the chart.
   **Values:**
   - Relative to Same Column. Makes the bar length proportional to other bars in the same column. Select this option when displaying horizontal bars. For example, the Budget Cost bar in a row for $500,000 shows twice as tall as the Budget Cost bar in a row for $250,000.
   - Relative to Same Row. Makes the bar proportional to all other bars in the same row. Select this option when displaying vertical bars. For example, the Budget Cost bar with a value of $500,000 shows twice as tall as the Budget Benefit bar with a value of $250,000.
   - Relative to Entire Table. Makes the bar proportional to all bars of the same type (vertical or horizontal) in the entire table. For example, in a grid with the Budget Cost column as a vertical bar, a row with a Budget Cost of $500,000 appears twice as tall as the Budget Cost of $250,000 in another row.
No Scaling. Draws all bars to the maximum length. Select this option to create progress bars.

For example, you can have an ETC (estimated time of completion) column with actuals as the threshold value. The part under the threshold shows how much work is already done. The part over the threshold shows how much work remains to be done. By looking at a column of these bar charts, you can quickly see how close each task is to being complete relative to the others.

Color

Specifies the color for the primary bar.

Threshold Line Attribute

Defines the attribute that holds the threshold value. In bar charts, a vertical line marks the threshold value.

Over-threshold Color

Defines the color to represent values greater than the threshold value. Any portion of the primary bar that extends past the threshold is drawn in the over-threshold color. Any portion of the secondary bar that extends past the threshold is drawn in a darker shade of the same color.

Link

Specifies the page to display when the user clicks the primary bar. To open the page in a pop-up window, select Open as Pop-up.

Stacked Attribute

Specifies the attribute to represent as a stacked bar.

Color

Specifies the color for the stacked bar.

Secondary Value

Specifies the value to display when the user moves a cursor over the secondary bar.

Link

Specifies the page to display when the user clicks the secondary bar.

7. Save your changes.

Display a Progress Bar

Add a progress bar field to a list view to show progress over time. The new virtual field displays in the far right column of the list by default. You can move the virtual field to a different position in the list.

Note: The option to display progress bars is not available for custom objects.
Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
   The list of views appears.
4. In the Category column, locate the List view and click the [Fields] link in that row.
   The list column fields page appears.
5. Click New.
6. Click Progress Bar, and click Next.
7. Complete the requested information. The following fields require explanation:
   - **Current Stage Name**
     Specifies the field value to use for each stage in the progress bar. The value displays below the column label.
   - **Current Stage Number**
     Specifies the field value to use for the current stage in the progress bar.
   - **Number of Stages**
     Specifies the field value that defines the total number of stages in the progress bar.
   - **Show Label**
     Indicates whether the name of the current stage is displayed in the progress bar.
   - **Column Width**
     Defines the percentage of the row width that is allocated to the progress bar column.
8. Save your changes.

**Configure Display Mappings**

Configure the display mappings of an attribute to indicate a range of values using icons and colors. You can visually flag specific information in the following ways to enable users to scan a list quickly:
- Select whether to place the graphic before or after the content.
- Set up an unlimited number of graphics for a list column.
How to Configure the Views for an Object

Note: You can only display attributes as graphics if they are of the number data type.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click the attribute for which you want to display a graphic.
5. Complete the following steps in the Display Mapping Section:
   a. In the Type field, select Color or Icon.
   b. For each range beginning with the default bucket, select the appropriate color or icon.
   c. Enter a brief description about the color or icon in the Description field.
   d. Enter a number for the beginning of the range that the color or icon represents in the From field.
   e. Enter a number for the end of the range that the color or icon represents in the To field.
6. Repeat Step 5 to define any other ranges of numbers to color-code or represent by an icon.
7. Save your changes.
   The display mapping for the attribute is configured. You can now add the attribute to the list view and configure the display elements to display the range of values using icons and colors.

Display a Gantt Chart

Use a Gantt chart to show duration and progress over time in a list view. The Gantt chart appears by default in the far right column of the list. You can move the chart to a different position in the list.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the List view and click the [Fields] link in that row.
5. Click New.
6. Select Gantt, and click Next.
7. Complete the requested information. The following fields require explanation:

   **Start Date**
   Indicates the start date for the column spread.

   **Time Scale**
   Specifies the time period by which data displays (days, weeks, and so on).

   **Number of Time Periods**
   Defines the number of time periods that display.

   **Time Period Offset**
   Defines how to shift the beginning of the Gantt bar relative to the start date.
   Enter a positive or negative number of time periods into the field.
   A negative number in relation to the start date takes you back in time (days)
   from the actual start date. A positive number takes you forward from the start
date.

   **Show Group Header Row**
   Indicates whether the timescale displays above the Gantt bar. If you select this
   option, select a timescale value.

   **Item Name Attribute**
   Defines the type of information to display in the corresponding Gantt bar.

   **Start Date Attribute**
   Defines the start date of the corresponding Gantt bar display.

   **Finish Date Attribute**
   Defines the finish date of the corresponding Gantt bar display.

   **Milestone Attribute**
   Defines the attribute to designate as a milestone. You can only assign a
   milestone attribute for a task.

   **Progress Through Date Attribute**
   Defines the length of the black overlay line that shows how much work is
   complete. If you select the Progress Through Date Attribute, it overrides the
   Progress Percent Attribute.

   **Progress Percent Attribute**
   Defines the percentage that is used to move the green progress line relative to
   the length of the taskbar to indicate the completed work. If you select a value
   for this field, it overrides the Progress Through Date Attribute selection.

   **Label for Bar**
   Specifies the label text to display above each taskbar.
Additional Information Attribute

Specifies the field used in the text note when you hover over a taskbar. For example, to display the assigned resources for a task, when the cursor is over a taskbar, complete the following steps:

- Select Assigned Resources from the Additional Information Attribute field.
- Select Additional Information in the Show Mouseover field.

Show Mouseover

Specifies the information that you want to display in a text note when the mouse scrolls over an area of the Gantt chart.

Show Dates on Primary Bar

Indicate the dates to show in the primary bar by selecting the desired dates in the Available section and adding the dates to the Selected section. Change the order of the dates in the list using the arrows in the Selected section.

Secondary Bar

Specifies whether to display a second bar below the primary bar for comparison purposes. To show a secondary bar, specify the following information for the bar:

- The type of information to display.
- The start and finish dates for the bar.
- The progress through date attribute.
- The progress percent attribute.

8. Save your changes.

Display an Image Link

Add an image link that users can click to access another page. When you add an image link to a list view, the new virtual field displays in the far right column of the list by default. You can move the virtual field to a different position in the list. For example, you can add a resource icon next to each task name on the project tasks page. When a user clicks the resource icon, the task assignments page appears.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the List view and click the [Fields] link in that row.
5. Click New.
7. Complete the requested information. The following fields require explanation:

   **Image**
   Specifies the image to use in the grid column.

   **Link**
   Specifies the page to which you can navigate by clicking the image.

   **Open as Pop-up**
   Indicates whether the target page of the image link appears as a pop-up.

   **Disable Link Attribute**
   Disables the image link. If after creating the link you want to disable it, select this option.

8. Save your changes.

**Add Aggregation Rows to the View**

You can add aggregation rows to a list view for attributes that display monetary or numeric values. For example, you can add a Total Cost row to show the aggregated value for the Planned Cost column. The Total Cost row displays the total planned costs for all projects in a given fiscal year.

*Note:* The following procedure assumes that numeric attributes exist and you have added them to the list view.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
   The list of views appears.
4. In the Category column, locate the List view and click the [Aggregation] link from the Setup column in that row.
   The list aggregation page appears.
5. Click Add.
6. Complete the requested information. The following fields require explanation:

   **Label**
   Defines the name for the aggregation row.

   **Show**
   Indicates whether to display the name of the aggregation row.
Attribute
Defines the field value to use for aggregation.

Function
Specifies the aggregation function to calculate values for a selected field (cell) in the row. For example, Sum adds up all the values of the field for all instances on the view.

7. Save your changes.

Configure the Filter View

The filter view displays on list pages and helps users filter the items displayed in a list. You can specify whether the list filter is collapsed and shows only the filter field or expanded to show the filter options.

You can add a link named Build Power Filter in the filter views for users to build and save complex queries. For example, with a power filter, users can filter in the following ways:

- Use boolean operators
- Select the fields to search
- Specify whether to search on exact phrases or any word in a search phrase

Configure the filter view to add filtering attributes and link to the power filter builder.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
   The list of views appears.
4. In the Category column, locate the Filter view and click the [Layout] link in that row.
   The layout page appears.
5. In the Available list, select the attributes that you want to add to the list filter and move them to the Selected list.
6. Complete the requested information. The following fields require explanation:

   **Section Title**
   Defines the text that appears at the top of the section for the filter.

   **Default Filter State**
   Specifies whether the initial display of the filter is expanded or collapsed.
Allow Power Filter

Specifies whether the filter provides advanced search features.

7. Save your changes.

Display and Verify Custom Object Views

To display the views that you configured for your custom object, place the custom object at an appropriate location in the Application menu. By default all custom objects are added to the Custom Objects menu item in the Application menu hierarchy.

For example, if you create a Retrospective object to capture retrospective information for projects, the object is added to the Custom Objects menu item by default. To display the views that are associated with the Retrospective object, add this object to the Portfolio Management menu item. Project managers can then view and access the Retrospective object and views from the Portfolio Management menu item in the Home menu.

Note: When you configure the views for an existing object, you do not have to complete the steps in this procedure.

Follow these steps:

1. Open Administration, and from Studio, click Menu Manager.
2. Click Application Menu in the list.
   The menu hierarchy appears.
3. Scroll to the Custom Objects menu item at the bottom of the page.
4. Select the custom object and click Move.
5. Select the new menu item where you want to place your custom object.
6. Click Save and Return.
7. Open Home, and click the custom object name from the appropriate menu item.
   For example, from Portfolio Management, click Projects.
   Note: If you do not see your changes reflected in the menu, click Refresh.
8. Create object instances and verify the views that you configured. For example, click New to create a project instance and verify the project view configurations.

   After you display and verify all views for your custom object, the configuration of object views is complete.
How to Create a Custom Object

Create a custom object in Studio to define the attributes or fields that make up your configured version of CA Clarity PPM pages.

The product provides default objects that are available for you to use. Use the default objects with no changes, or create custom objects and subobjects to create and manage information for your specific business needs.

Example: Project Retrospective Summary Report

In this example, project managers at Forward, Inc. provide a retrospective summary report to upper management at the end of a product release cycle. To gather project information for this report, the project managers use a retrospective form that the project participants complete. To help the project managers create and manage the retrospectives in the product, the system administrator sets up the following framework in Studio:

- A master object named Survey with the following attributes to capture information about projects:
  - Project Name (lookup attribute)
  - Start Date and End Date (date attribute)
  - Project Manager (lookup attribute)
  - Team Members (lookup attribute)

- A subobject named Retrospective with Survey as its parent object and the following attributes:
  - What Went Well (string attribute)
  - Areas for Improvement (string attribute)
The following diagram describes how a system administrator creates a custom object:

Perform these steps to create a custom object:

1. **Review the Prerequisites** (see page 42).
2. **Create an Object** (see page 45).
3. **Create Attributes** (see page 45):
   - **Create an Attachment Attribute** (see page 46).
   - **Create a Boolean Attribute** (see page 47).
   - **Create a Calculated Attribute** (see page 48).
How to Create a Custom Object

- Create a Date Attribute (see page 50).
- Create a Formula Attribute (see page 51).
- Create a Single Value Lookup Attribute (see page 53).
- Create a Multi Valued Lookup Attribute (see page 54).
- Create a Money Attribute (see page 55).
- Create a Number Attribute (see page 57).
- Create a Parameterized Lookup Attribute (see page 58).
- Create a String Attribute (see page 59).
- Create a Time-varying Attribute (see page 60).
- Create a URL Link Attribute (see page 62).

4. Add Attributes to the Object Properties View (see page 63).
5. Add Attributes to the Object List Filter View (see page 63).
6. Add Attributes to the Object List Column View (see page 64).
7. Grant Access to the Object (see page 65).
8. Add a Menu Page Link for the Object (see page 65).

Review the Prerequisites

Review the following prerequisites to help ensure that you can successfully create a custom object.

Predefined Setup

This scenario assumes that you have set up the following:

Partitions

Set up partitions if you want to associate the object attributes with a particular partition. Associating object attributes to partitions allows you to create different presentations of the same objects for different users.

Note: For more information about setting up partitions, see the Studio Developer’s Guide.

NSQL queries

Create NSQL queries if you plan to use a parameterized lookup. Create the NSQL queries ahead of time so you can map the query parameters to the object.

Note: For more information about setting up partitions, see the Studio Developer’s Guide.
Organizational breakdown structure (OBS)

Create your organizational breakdown structure for the following purposes:

- Associating the OBS to your object instances to control access across department hierarchies, and reporting.
- Creating fiscal time-scaled values using the time-varying attribute data type.

**Note:** For more information about setting up your OBS, see the *Administration Guide*.

**Note:** For more information about creating custom fiscal timescale values, see the *Studio Developer’s Guide*.

Lookup attributes definition

Create the lookup that you want to add to a single value or Multi Valued Lookup data type attribute.

**Note:** For more information about creating lookups, see the *Studio Developer’s Guide*. 
Reserved words

When creating an object, do not use the following reserved words for the object name or object ID:

- asset
- application
- company
- contract
- discussion
- glallocation
- idea
- incident
- incidentcategory
- investmentallocation
- investmenthierarchy
- invoice
- invoiceitem
- invoicetransaction
- other
- product
- release
- releaseplan
- requirement
- requisition
- resourcecredit
- service
- subscription

Custom attributes

Consider the following information for custom attributes:

- Verify that the attributes you create meet the needs of your users. Once you create an attribute, you cannot remove it from the object. You can only deactivate it so that it does not display.

- Create only the attributes needed. You can add many custom attributes to an object. However, the number of attributes affects the amount of time it takes to display pages, so do not create more attributes than you need.

**Important!** The product supports up to 500 custom attributes for each object. However, we strongly recommend that you do not assign more than 100 custom attributes to a single custom object. High numbers of custom attributes for an object may result in performance issues and subsequent upgrades may fail. If you need a large number of custom attributes, consider creating and using a subobject rather than assigning a large number of custom attributes to a single object.
Create an Object

Create an object in Studio so that users can create instances of the object in the product. For example, create an object named Survey in Studio, so that users can create multiple surveys.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click New.
3. Complete the requested information. The following fields require explanation:
   - **Master or Subobject**
     - Specifies whether an object is a master object or a subobject.
     - Values:
       - Master. Specifies that the object is not the child of another object. Select the partition model of the master object in the Partition Model field. The default is the System partition model.
       - Subobject. Specifies that the object is the child of another object. Select the master object of the subobject in the Master Object field.
   - **Event Enabled**
     - Specifies that the process engine is notified of object instances that are created or updated.
   - **Copy Enabled**
     - Specifies that copies can be made of the object instances.
   - **Export Enabled**
     - Specifies that object instances can be exported to XML.
   - **View All Enabled**
     - Specifies that the object instances can have a view containing all properties, subobject lists, and page portlets that can be personalized on a single page.
4. Save your changes.

Create Attributes

Attributes are information that is associated with object views (pages). For example, Start Date and End Date are attributes of the Project object.

The product provides default attributes that you can use. You can change how a default attribute appears, but you cannot change the attribute general information (such as, name, ID, description, data type, or lookup).
Create an Attachment Attribute

Create an attachment attribute to provide a link that users can click to download documents. The attribute appears as a link in list pages and as an editable text attribute with open and delete icons in property pages. When you click the open icon, a document that is associated with the attribute is downloaded or displayed.

An attachment attribute can display links for a maximum of ten documents. Use the product search utility to find content in document attachments.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:

   **Partition**
   Specifies the partition to associate with the attribute.

   **Partition Association Mode**
   Specifies which partitions can include the attribute, in addition to the selected partition.

   **Data Type**
   Defines the data type for the field. Select Attachment.

   **Attachment Style**
   Specifies whether you can attach single or multiple documents. If you select Multiple Documents, enter the number of attachments allowed.

   **Value Required**
   Specifies whether a value is required for the attribute.

   **Presence Required**
   Specifies that the attribute always appears in the Edit Properties view.

6. Save your changes.
Create a Boolean Attribute

Create a boolean attribute to indicate one of two exclusive conditions. An Active check box for a project is an example of a boolean attribute which when selected is true and false when cleared.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:
   - **Partition**
     Specifies the partition to associate with the attribute.
   - **Partition Association Mode**
     Specifies which partitions can include the attribute, in addition to the selected partition.
   - **Data Type**
     Defines the data type for the field. Select Boolean.
   - **Populate Null Values with the Default**
     Specifies whether to populate existing objects automatically with the default value.
   - **Presence Required**
     Specifies that the attribute always appears in the Edit Properties view.
6. (Optional) To display the attribute in color, complete the following steps in the Display Mappings Section.
   a. In the Type field, select Color.
   b. In the Color field, select a color.
   c. Enter a brief description of the color representation in the Description field.

Repeat this step to define any other values to color-code.
7. (Optional) To display the attribute as an icon, complete the following steps in the Display Mapping Section:
   a. In the Type field, select Icon.
   b. In the Icon field, select the icon to represent the true or false state.
   c. Enter a brief statement of the icon representation in the Description field.
      Repeat this step to define any other values to represent by an icon.

8. Save your changes.

Create a Calculated Attribute

Create a calculated attribute to display a field with a read-only value that is calculated dynamically. For example, create a Variance attribute that is calculated as Planned Cost minus Actual Cost in the project budget page.

To create a calculated attribute, complete the following required steps:
1. Create the attribute (see page 48).
2. Build an expression for the attribute (see page 49).

Create the Attribute

Create a calculated attribute placeholder so you can build an expression for the placeholder attribute to make it a calculated attribute.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:
   - **Partition**
     Specifies the partition to associate with the attribute.
   - **Partition Association Mode**
     Specifies which partitions can include the attribute, in addition to the selected partition.
   - **Data Type**
     Defines the data type for the field. Select Calculated.
Result Data Type

Specifies the data type for the result of the calculation (Number, String, or Date).

Decimal Places

 Defines the number of decimal places to return for the attribute. To specify the attribute as an integer, enter a zero (0).

Presence Required

Specifies that the attribute always appears in the Edit Properties view.

6. Save your changes.

Build an Expression for the Attribute

Build an expression to calculate a value for the new attribute. You can use one of the following methods:

- Generate the expression in Studio.
  
  For example, a generated expression for the sum of three numbers (num1, num2, and num3) appears in the Expression text box in the following format:
  
  \( \text{Sum}(\text{num1}, \text{num2}, \text{num3}) \)

- Manually enter the expression.
  
  Use the following unary operators: +, -, *, and / when the result data type is Number. For example, you can manually enter the sum of three numbers can be entered manually in the Expression text box as (\( \text{num1+num2+num3} \)). The unary operators replace the Add, Sum, Multiply, Divide, and Subtract functions.

Follow these steps:

1. With the calculated attribute open, click the Build Calculated Attribute link located in the Calculation field.

2. Select the appropriate function in the Function field.

3. Select the number of arguments in the Argument Number field.
   
   If the selected function has a specific number of arguments, the field is read-only. If you can vary the number of arguments in the function, make a selection from the drop-down list.

4. Create the arguments for the function expression by selecting one of the following options for each argument listed:
   
   - Constant. The value that remains the same for all calculations.
   
   - Attribute Name (ID). The attribute for which values are included in the calculation. The list shows the available object attribute names for the data type selected (number, string, or date).
- **Sub-expression.** The option that allows you to embed an expression within the expression that you are building for the calculation.

5. **Click Generate**
   The function expression in the Expression text box is generated.

6. If you selected the Sub-expression argument option, complete the following steps:
   a. In the Generate Expression for field, select the name of the sub-expression.
   b. In the Function field, select the function that defines the purpose of the sub-expression.
   c. Select and define the arguments for the sub-expression.
   d. Click Generate.
      The defined arguments for the sub-expression in the whole expression is included.

7. After all sub-expressions are defined for the whole expression, click Validate to verify that the expression syntax is correct and make any necessary adjustments.

8. Save your changes.

**Create a Date Attribute**

Create a date attribute to provide a field where users can enter a date or can select a date by clicking a calendar icon. For example, you can provide fields for the Start Date or End Date attributes on the project schedule page.

**Follow these steps:**
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:

   **Partition**
   Specifies the partition to associate with the attribute.

   **Partition Association Mode**
   Specifies which partitions can include the attribute, in addition to the selected partition.

   **Data Type**
   Defines the data type for the field. Select Date.
Validation From

Specifies the earliest date to include in the date attribute. Select Rolling Date or Specific Date and the specific values that you want for your selection. If needed, specify the hour and minute.

Validation To

Specifies the latest date to include in the date attribute. Select Rolling Date or Specific Date and the specific values that you want for your selection. If needed, specify the hour and minute.

Default Date

Specifies the default date for the date attribute. Select Rolling Date or Specific Date and the specific values that you want for your selection. If needed, specify the hour and minute.

Populate Null Values with the Default

Specifies whether to populate existing objects automatically with the default value.

Value Required

Specifies whether a value is required for the attribute.

Presence Required

Specifies that the attribute always appears in the Edit Properties view.

6. Save your changes.

Create a Formula Attribute

Create a formula attribute to calculate the weighted average of two or more attributes in the same object. This attribute is similar to a calculated attribute, but you can build a weighted average. For example, the value for the Risk Drivers attribute is based on the Risk Likelihood and Risk Priority attributes with Risk Likelihood weighing twice as much as Risk Priority.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:

Partition

Specifies the partition to associate with the attribute.
Partition Association Mode

Specifies which partitions can include the attribute, in addition to the selected partition.

Data Type

Defines the data type for the field. Select Formula.

Decimal Places

Defines the number of decimal places to return for the attribute. To specify the attribute as an integer, enter a zero (0).

6. (Optional) To display the field in color or as an icon, complete the following steps in the Display Mapping Section:
   a. In the Type field, select Color or Icon.
   b. Select the appropriate color or icon.
   c. Enter a brief description of the color or icon representation in the Description field.
   d. Enter a number for the beginning of the range that the color or icon represents in the From field.
   e. Enter a number for the end of the range that the color or icon represents in the To field.

   Repeat this step to define any other ranges of numbers to color-code or represent by an icon.

7. Click Save.

8. In the Formula field, click [Build Weighted Average Formula] to add a weighted average formula.

9. Complete the following fields:

   Attribute

   Specifies the attribute that you want to give consideration in the weighted average calculation.

   Weighting

   Specifies the value to multiply by the value of the attribute you selected to compute the weighted average for a row. The product adds the weighted values from all rows and computes the average. The entries that you make in the Weighting column prioritize the attribute over other attributes when calculating the weighted average. If you leave the Weighting column empty, an ordinary arithmetic average is computed.

   Example: weighted ave=([Risk * 4] + [Customer Satisfaction * 2] + [Alignment * 1]) / 3
10. To add weights to additional attributes, click New Row for each attribute.
11. To see if the formula for the weighted average works as expected, click Recalculate.
12. Save your changes.
   The page displays the formula results in the Test section.

Create a Single Value Lookup Attribute

Create a single value lookup attribute to display a drop-down or a browse list from which users can select only one value. For example, the Status attribute on a project that contains the values Approved, Not Approved, and Rejected is a single-value lookup attribute.

A single value lookup attribute can include the following source types:

- **Static List.** Provides a list of values that do not change (for example, action item status). If you select a static list lookup, you can set up a display mapping to associate a value with a description and a color or icon. These colors or icons can be used in many places throughout the product, such as in stoplight icons, filters, progress bars, Gantt charts, and chart backgrounds.

- **Dynamic Query.** Provides a list of values that are dynamic based on the NSQL query. For example, a list of active and locked resources.

**Follow these steps:**
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:

   - **Partition**
     Specifies the partition to associate with the attribute.

   - **Partition Association Mode**
     Specifies which partitions can include the attribute, in addition to the selected partition.

   - **Data Type**
     Defines the data type for the field. Select Lookup.

   - **Lookup**
     Specifies the lookup that appears in the field (static list or dynamic query) displaying a list of options that the user can select.
How to Create a Custom Object

**Default**

Specifies the default value for the attribute.

**Populate Null Values with the Default**

Specifies whether to populate existing objects automatically with the default value.

**Value Required**

Specifies whether a value is required for the attribute.

**Presence Required**

Specifies that the attribute always appears in the Edit Properties view.

6. (Optional) To set up a display mapping for a static lookup, complete the following steps. You cannot set up a display mapping for a dynamic query.

a. In the Type field, select Color or Icon.

b. Select the appropriate color or icon.

c. Enter a brief description of the color or icon representation in the Description field.

d. Select the lookup value to represent by the color or icon in the Value field.

You can define a color or icon for up to ten values in addition to an optional Default Bucket for all values that do not have an assigned color or icon.

Repeat this step to define any other values to color-code or represent by an icon.

7. Save your changes.

**Create a Multi Valued Lookup Attribute**

Create a Multi Valued Lookup attribute to display a drop-down list or a browse icon from which users can select one or more items.

On a properties page, the Multi Valued Lookup attribute displays as a multiple select browse field. In a filter, the attribute can display as a drop-down list, select box, or a multiple select browse field.

Multi Valued Lookup attributes are frequently used in filters. For example, the Approvers field on a project where you assign a list of resources as approvers for the project is a multi valued lookup attribute.

You cannot use Multi Valued Lookup attributes in display mappings.
Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:
   - **Partition**
     Specifies the partition to associate with the attribute.
   - **Partition Association Mode**
     Specifies which partitions can include the attribute, in addition to the selected partition.
   - **Data Type**
     Defines the data type for the field. Select Multi Valued Lookup.
   - **Lookup**
     Specifies the lookup that appears in the field displaying a list of options that the user can select.
   - **Default**
     Specifies the default value for the attribute.
   - **Populate Null Values with the Default**
     Specifies whether to populate existing objects automatically with the default value.
   - **Presence Required**
     Specifies that the attribute always appears in the Edit Properties view.
6. Save your changes.

Create a Money Attribute

Create a money attribute that lets users enter a monetary value in a field. For example, the Planned Cost field for a project allows users to enter a planned cost amount in dollars.

The product associates money attributes with a currency code so that you can convert the value to another currency if necessary.
How to Create a Custom Object

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:
   - **Partition**
     Specifies the partition to associate with the attribute.
   - **Partition Association Mode**
     Specifies which partitions can include the attribute, in addition to the selected partition.
   - **Data Type**
     Defines the data type for the field. Select Money.
   - **Currency Code Location**
     Specifies that the attribute has its own currency code field. Select the default currency code in the Default Currency Code field.
   - **Validation Range**
     Defines the range of values that is allowed for the attribute. Enter the lowest value in the first box and the highest value in the second box.
   - **Default Value**
     Specifies the default value for the attribute.
   - **Populate Null Values with the Default**
     Specifies whether to populate existing objects automatically with the default value.
   - **Presence Required**
     Specifies that the attribute always appears in the Edit Properties view.
6. (Optional) To display the field in color or as an icon, complete the following steps in the Display Mappings section:
   a. In the Type field, select Color or Icon.
   b. Select the appropriate color or icon.
   c. Enter a brief description of the color or icon representation in the Description field.
d. Enter a number for the beginning of the range that the color or icon represents in the From field.

e. Enter a number for the end of the range that the color or icon represents in the To field.

Repeat this step to define any additional ranges of numbers to color-code or represent by an icon.

7. Save your changes.

Create a Number Attribute

Create a number attribute that lets users enter a numeric value in a field. For example, the Priority field on the project Create page lets users prioritize a project using a numeric value where a higher number indicates a higher priority.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:

   **Partition**
   Specifies the partition to associate with the attribute.

   **Partition Association Mode**
   Specifies which partitions can include the attribute, in addition to the selected partition.

   **Data Type**
   Defines the data type for the field. Select Number.

   **Validation Range**
   Defines the range of values that is allowed for the attribute. Enter the lowest value in the first box and the highest value in the second box.

   **Decimal Places**
   Defines the number of decimal places to return for the attribute. To specify the attribute as an integer, enter a zero (0).

   **Show as Percent**
   Indicates if the value entered in the field displays as a percent.

   **Default Value**
   Specifies the default value for the attribute.
Populate Null Values with the Default

Specifies whether to populate existing objects automatically with the default value.

Presence Required

Specifies that the attribute always appears in the Edit Properties view.

6. (Optional) To display the field in color or as an icon, complete the following steps in the Display Mappings section:
   a. In the Type field, select Color or Icon.
   b. Select the appropriate color or icon.
   c. Enter a brief description of the color or icon representation in the Description field.
   d. Enter a number for the beginning of the range that the color or icon represents in the From field.
   e. Enter a number for the end of the range that the color or icon represents in the To field.

Repeat this step to define any other ranges of numbers that to color-code or represent by an icon.

7. Save your changes.

Create a Parameterized Lookup Attribute

Create a parameterized lookup attribute to allow mapping between NSQL query parameters and the appropriate object attributes. This attribute type restricts the choices for users, which are based on their previous field selections. For example, the user selects California from a list of states. In a later field, the cities from which they can select include only California cities.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:
   
   **Data Type**
   
   Defines the data type for the field. Select Parameterized Lookup.
   
   **Lookup**
   
   Specifies the lookup that is associated with the NSQL query you want to map.
Default

Specifies the default value for the attribute.

Populate Null Values with the Default

Specifies whether to populate existing objects automatically with the default value.

Value Required

Specifies whether a value is required for the attribute.

Presence Required

Specifies that the attribute always appears in the Edit Properties view.

6. Save your changes.

The Lookup Parameter Mappings section displays at the bottom of the page. The parameters listed are from the NSQL code for the lookup that is associated with the new attribute.

7. For each lookup parameter listed, select an object attribute ID.
8. Save your changes.

Create a String Attribute

Create a string (text) attribute to let users enter more detailed information about an object. For example, the Description field on a project Create page allows users to describe the purpose and goal of the project or include any additional project details.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:
   
   Partition

   Specifies the partition to associate with the attribute.

   Partition Association Mode

   Specifies which partitions can include the attribute, in addition to the selected partition.
Data Type

Specifies the data type for the field. Select String.

Values:

- String. Creates a field with a maximum of 2,000 characters.
- Large String. Creates a field with an unlimited number of characters.
- **Note**: When you use the Large String data type, you cannot display the large string attributes in list filter views. In addition, you cannot sort large string attributes.

Default Value

Specifies the default value for the attribute.

Maximum Size

Defines the maximum size of the attribute up to 2,000 characters.

Populate Null Values with the Default

Specifies whether to populate existing objects automatically with the default value.

Value Required

Specifies whether a value is required for the attribute.

Presence Required

Specifies that the attribute always appears in the Edit Properties view.

6. Save your changes.

Create a Time-varying Attribute

Create a time-varying attribute to allow users to enter information that changes over time. For example, use a time-varying attribute to track resource allocation (as a percentage) over the lifecycle of a project task.

**Note**: Use only alphanumeric and underscore (_) characters when entering a unique ID for a time-varying attribute. Also, avoid SQL reserved words such as SELECT or STRING.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:
Partition

Specifies the partition to associate with the attribute.

Partition Association Mode

Specifies which partitions can include the attribute, in addition to the selected partition.

Data Type

Defines the data type for the field. Select Time-varying.

Time-varying Data Units

Specifies the unit that the time-scaled value represents, such as a number value, a monetary value, or a percentage.

A fiscal time-scaled value that is created with a time-varying data unit set to Money has its currency code set to the system currency.

When you create an instance of this fiscal time-scaled value, the currency code is set to the home currency of the associated financial entity.

Time-varying Unit Conversion

Specifies whether the time-varying data units are for each hour or for each second.

Time-varying Date Constraints

Defines time constraints to limit the range of data that is received for the attribute and improve processing performance. You can enter dates that override these dates. If you do not select a value, the default values include the widest available range.

6. For a multi currency system with money as the time-varying data unit, select one of the following options to specify the currency code location and a currency code for the attribute:

   ■ Attribute has its own currency code field. Select the default currency code for this option.

   ■ Reference another attribute of this object. Select the field that contains the currency code for this option.

7. Save your changes.
Create a URL Link Attribute

Create a URL Link attribute to provide links to web pages or virtual attributes.

- A link attribute provides a link to a URL (web page) that is outside of the product.
- A virtual attribute references an attribute that is derived from data attributes of items that exist outside of the database. Examples of virtual attributes are progress bars, Gantt charts, or attributes that display the calculated results for other attributes.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Attributes.
4. Click New.
5. Complete the requested information. The following fields require explanation:
   - **Partition**
     Specifies the partition to associate with the attribute.
   - **Data Type**
     Defines the data type for the field. Select URL.
   - **Default Value**
     Specifies the default URL value for the attribute.
   - **Maximum Size**
     Defines the maximum number of characters that can be used for the attribute. The maximum size for a string field is 1,000 characters.
   - **Populate Null Values with the Default**
     Specifies whether to populate existing objects automatically with the default value.
   - **Value Required**
     Specifies whether a value is required for the attribute.
   - **Presence Required**
     Specifies that the attribute always appears in the Edit Properties view.
6. Save your changes.
Add Attributes to the Object Properties View

Add the attributes to the properties view of the new object so users can complete the following tasks from the object properties page:

- Create an initial instance of the object.
- Modify the created instance of the object.

You can specify which attributes are visible, their location on the page, and the order in which the attributes display.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
   The list of views appears.
4. In the Category column, locate the Properties view and click the [Layout:Create] link from the Setup column in that row.
5. In the property layout, select the section to which you want to add the attribute, and click the Properties and Layout icon next to the item.
   List boxes of available and selected attributes appear.
6. In the Available list, select the attributes that you want to add and use the arrows to move the attributes into the correct Selected list box.
7. Click Save and Return.
8. Click Return.
   The list of views appears.
9. In the Category column, locate the Properties view and click the [Layout:Edit] link from the Setup column in that row.
10. Repeat Steps 4 through 7.

Add Attributes to the Object List Filter View

Add attributes to the list filter view of the object so that users can complete the following tasks:

- Search for information that is based on object attributes.
- Use a filter to limit the information that they want to view. For example, users can use the filter on the project team staff page to view information only for unfilled roles.
**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
4. In the Category column, locate the List Filter view and click the [Layout] link from the Setup column in that row.
   
   The list filter layout page appears.
5. In the Available list, select the attributes that you want to add to the list filter, and use the arrows to move the attributes to the appropriate columns.
6. Complete the following fields in the Settings section:
   
   - **Section Title**
     
     Defines the text that appears at the top of the section for the filter.
   - **Default Filter State**
     
     Specifies whether the initial display of the filter is expanded or collapsed.
   - **Allow Power Filter**
     
     Specifies whether the filter provides advanced search features.
7. Save your changes.

**Add Attributes to the Object List Column View**

Add attributes to the list column view of the object to define the sorting of the attributes that are displayed as columns on list pages. For example, you can sort the list of projects primarily by the Project Name attribute in ascending order.

You can add up to four attributes that sort a List Column view. The attributes can be user-defined, default, or both.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object.
3. Click Views.
   
   The list of views appears.
4. Next to the List Column view, click the Layout link.
   
   The list column layout page appears.
5. Specify the primary sort column in the Column Sorting section, by selecting an attribute in the First Field row.
6. To indicate the direction of the sort, select Ascending or Descending.

7. To indicate additional sort columns, select attributes for the remaining fields in the Column Sorting section.

8. Save your changes.

Grant Access to the Object

Grant access rights to users, OBS units, or groups for the object that you created, so that users can open and edit the definition for the object.

Follow these steps:

1. Open Administration, and from Studio, click Objects.

2. Click the name of the object, click Access to this Object, and select one of the following options:
   - Resource. Grants access to individual resources.
   - Group. Grants access to defined groups of resources.
   - OBS Unit. Grants access to defined OBS units containing resources.

3. Click Add.
   
   A list of access rights appears.

4. Select the check boxes next to the access rights you want to grant, and click Add and Continue.

   A list appears with a list of resources, groups, or OBS units.

5. Select the check boxes next to each resource, group, or OBS unit to which you want to grant access.

6. Click Add.

Add a Menu Page Link for the Object

Add a menu link for the object so that users can access the pages for the object from the Home or Administration menu.

Follow these steps:

1. Open Administration, and from Studio, click Menu Manager.
2. Click the name of the menu you want to edit.
   The menu hierarchy appears.

3. Click Add.

4. Select Page Link and click Next.
   The menu item properties page appears.

5. Enter the information for the new page link.
   The following fields require explanation:

   **Link Name**
   Defines the label for the page link that appears in the menu.

   **Page Name**
   Specifies the page that appears when the link is clicked.

   **Parent Menu Item**
   Specifies the menu section in which the link appears.

6. Click Save and Return.
   After you add a menu page link to your object, the creation of your custom object is complete.
How to Create a Portlet Page

Portlets are snapshots into CA Clarity PPM data and can consist of grids or charts.

While portlets do not replace reports, they can be considered mini-reports. A portlet page is comprised of a set of portlets or small windows of information that appear automatically for users with the appropriate access privileges. You can configure a portlet page to allow users to personalize the page as follows:

- Decide which portlets to show or hide on the page.
- Decide where to show the portlets on the page.

Create a portlet page to collect or display information in real time for users.

A portlet page can contain tabs or no tabs. Create one or the other depending on the amount of information that you want to display and how you want to organize the information. The following examples provide guidance for creating portlet pages without tabs and with tabs:

- Create a portlet page without tabs to display a single page containing a few portlets displaying retrospective information for projects.
- Create a portlet page with tabs to display a wide range of project information under different tabs such as Team, Tasks, and Financial Plans.

The new page layout varies completely from the default page layout for projects. The new layout includes a portlet page with multiple tabs and each tab groups a specific type of information about projects.
The following diagram describes how a system administrator creates a portlet page.
Perform these steps to create a portlet page:

1. **Plan the Portlet Page** (see page 69)

2. **Create the Portlet Page** (see page 70):
   - Set Up a Portlet Page with Tabs (see page 71):
     - Create a Portlet Page with Tabs (see page 71).
     - Create Tabs (see page 72).
     - Configure a Tab (see page 73).
   - Set Up a Portlet Page without Tabs (see page 74):
     - Create a Portlet Page without Tabs (see page 75).
     - Configure the Portlet Page without Tabs (see page 76).

3. **Set Up Link Parameters for the Portlet Page** (see page 77).

4. **Assign User Access to the Portlets** (see page 77).

5. **Assign User Access to the Portlet Page** (see page 78).

6. **Add Portlet Page to Menu Manager and Verify** (see page 79).

**Plan the Portlet Page**

Consider the following information to plan your portlet page before creating it:

- Decide whether the new page contains tabs. You can select a page type with or without tabs. Pages with tabs can provide a useful way to group several related pages under a menu item.

- Determine how a page is used to decide on which menu the link to the page is placed. An end-user page is placed in the Home menu, and an administrator page is placed in the Administration menu.

- Decide how much control users have for the page. You can control whether a page can be personalized so that users can add portlets and can create additional tabs. Once a user personalizes a page, changes made in Studio (except the addition of required portlets) do not affect those changes. To ensure that all users see the same page and any future changes, disable the Personalizable option.

- Verify that the portlets exist that you want to display on the portlet page as content. Also verify that the page filters exist that you want to display on the portlet page to allow users to filter the information on the page. This scenario does not explain how to create portlets and page filters.
Verify that any user object actions exist that you add to the portlet page. For example, the project properties page includes the following user object actions by default:

- Add to My Projects
- Copy Project from Template

Without these object actions, users have to navigate to the page that has the Add to My Projects or the Copy Project from Template option to perform these actions. Adding object actions to a page allows users to place the actions where it is most appropriate. They do not need to navigate away from the page they are working on.

This scenario does not explain how to create object actions.

Assign the following access rights to users so they can access the portlet page and portlets:

- Portlet - View
- Portlet - Navigate
- Page - View

Create the Portlet Page

You can create the following types of portlet pages:

- Page without Tabs. Allows you to display all of the content by organizing it on a single page. Use a portlet page without tabs when the amount of content is minimal and you do not need to group information under different tabs. The System Options page under the Administration menu is a good example of a portlet page without tabs. The page simply groups all of the information under different sections on the same page.

- Page with Tabs. Allows you to group several related pages of information under a single menu item. When you click a project instance from the projects list page, the resulting page is an example of a portlet page with tabs. The following tabs help group various project information on the page:
  - Team. Groups all project team-related information.
  - Tasks. Groups all tasks and assignments information.
  - Financial Plans. Groups all types of financial plans (cost plans, budgets plans, and benefit plans).

- Object portlet pages for master objects (for example, Project) or custom objects. Allows you to add portlets under a Dashboard tab or any custom tab you create when creating a portlet page.
To create a portlet page, complete one of the following tasks:

- Set Up a Portlet Page with Tabs (see page 71).
- Set Up a Portlet Page without Tabs (see page 74).

**Set Up a Portlet Page with Tabs**

Set up a portlet page with tabs to display information that is better organized by grouping them under different tabs. For example, the project properties page is a portlet page with tabs that groups the following types of information under different tabs:

- Team
- Task
- Financial Plans

To set up a portlet page with tabs, complete the following tasks in the recommended order:

1. Create a Portlet Page with Tabs (see page 71).
2. Create Tabs (see page 72).
3. Configure a Tab (see page 73).

**Create a Portlet Page with Tabs**

Create a portlet page with tabs to group several related pages under a menu item. If you have numerous portlets, create a portlet page with tabs to help improve the organization of the information. For example, the project properties page is a portlet page with tabs that groups various project information under tabs such as Team, Task, or Financial Plans.

**Follow these steps:**

1. Open Administration, and from Studio, click Portlet Pages.
   
   The portlet pages list page appears.
2. Click New.
3. Complete the requested information. The following fields require explanation:

   **Content Source**

   Specifies where the data that appears in a portlet or portlet page originates.

   **Default:** Customer

   **Type**

   Specifies the type of page you want to create. Select Page with Tabs to create a portlet page with tabs.
How to Create a Portlet Page

Layout
Specifications how portlets added to a page or a tab appear. The number of columns indicates the number of portlets for each row and the percentage of the page that is given to each portlet. The Row layout can have one to three portlets in a row with equal space provided for each portlet.

Personalizable
Specifications if a user can make personal changes to a page or a tab. Only the user who changes the page or tab sees the changes.

4. Click Save and Continue.

The OBS section appears.

5. If you are using OBS, complete the following fields:

   Department
   Specifies the OBS department that is associated with the portlet page.

   Location
   Specifies the OBS location that is associated with the portlet page.

6. Save your changes.

Create a Tab

Create tabs for the portlet page so you can group the information that you want to display on the page in meaningful ways. For example, the Team tab on the project page groups staff-related information; the Task tab groups all project tasks, and so on.

Follow these steps:

1. Open Administration, and from Studio, click Portlet Pages.

   The portlet pages list page appears.

2. Click the name of the portlet page.

3. Click Tabs.

4. Click New.

5. Complete the requested information. The following fields require explanation:

   Content Source
   Specifies where the data that appears in a portlet or portlet page originates.

   Default: Customer
Layout

Specifies how portlets added to a page or a tab appear. The number of columns indicates the number of portlets for each row and the percentage of the page that is given to each portlet. The Row layout can have one to three portlets in a row with equal space provided for each portlet.

Personalizable

Specifies if a user can make personal changes to a page or a tab. Only the user who changes the page or tab sees the changes.

Linkable

Specifies if you want users to be able to link to the tab from another page. If you select this option, the Link Parameters tab activates and you can set up link parameters for the tab.

6. Click Save and Return to create additional tabs.

Configure a Tab

For a portlet page with tabs, you can configure the tabs to enhance them in the following ways:

- Add a link parameter to create a link to the tab.
- Add existing portlets to the tab.
- Add a filter to filter information on the tab.
- Design the portlet layout.

For example, to create a portlet page with tabs displaying project retrospective information using Project, Release, and Retrospective tabs, configure the Retrospective as follows:

- Add a link to the tab from the Project tab.
- Add existing Release and Project portlets to the tab.
- Add a filter to allow users to filter on specific project retrospective fields.
- Arrange the portlets on the tab so that content is evenly distributed.

Follow these steps:

1. Open Administration, and from Studio, click Portlet Pages.
   The portlet pages list page appears.
2. Click the name of the portlet page.
3. Click Tabs.
4. Click the name of the tab to configure.
5. (Optional) Complete the following steps to add a linkable parameter:
   a. Click Link Parameters.
   b. Click New and complete the requested information.
   c. Click Save and Return.
6. (Optional). Complete the following steps to add portlets:
   a. Click Content.
   b. Click Add.
   c. Select the portlets that you want to add and click Add.
7. (Optional). Complete the following steps to add a filter:
   a. Click Page Filters.
   b. Click Add.
   c. Select the appropriate page filter and click Add.
8. (Optional). Complete the following steps to design the portlet layout:
   a. Click Layout.
   b. Place the portlets in the desired columns by selecting them and moving them to the appropriate columns.
   c. Change the number of columns using the Layout field at the top of the page.
   d. Click Save and Return.

Set Up a Portlet Page without Tabs

Set up a portlet page without tabs to display all the relevant content on a single page. For example, the License Information page in the Administration menu is a single portlet page without tabs. The page includes two portlets, one displaying user count for each license type and the other displaying access rights for each license type.

To set up a portlet page without tabs, complete the following tasks in the recommended order:
1. Create a Portlet Page without Tabs (see page 75).
2. Configure the Portlet Page without Tabs (see page 76).
Create a Portlet Page without Tabs

Create a portlet page without tabs to organize the content that you want to display to the users on a single page. The content is easily organized across one or more portlets on the same page. For example, the License Information page in the Administration menu is a portlet page without tabs.

Follow these steps:

1. Open Administration, and from Studio, click Portlet Pages.
2. Click New.
3. Complete the requested information. The following fields require explanation:
   - **Content Source**: Specifies where the data that appears in a portlet or portlet page originates. Default: Customer
   - **Type**: Specifies the type of page you want to create. Select Page without Tabs to create a single page.
   - **Layout**: Specifies how portlets added to a page or a tab appear. The number of columns indicates the number of portlets for each row and the percentage of the page that is given to each portlet. The Row layout can have one to three portlets in a row with equal space provided for each portlet.
   - **Personalizable**: Specifies if a user can make personal changes to a page or a tab. Only the user who changes the page or tab sees the changes.
4. Click Save and Continue.
   The Linkable option and the OBS section appear.
5. Specify if you want users to be able to link to the portlet page from another page. If you select the Linkable option, the Link Parameters tab activates and you can set up link parameters for the page.
6. If you are using an bOBS, complete the following fields:
   - **Department**: Specifies the OBS department that is associated with the portlet page.
   - **Location**: Specifies the OBS location that is associated with the portlet page.
7. Save your changes.
Configure the Portlet Page without Tabs

Configure the portlet page without tabs so you can enhance the page in the following ways:

- Add portlets to the page as content. The portlets must exist beforehand.
- (optional). Add a page filter. The filter must exist beforehand.
- Design the layout of portlets.

For example, to create a portlet page without tabs that displays project retrospective information, configure the page as follows:

- Add portlets to the page displaying content about projects, releases, and retrospectives.
- Add a filter to allow users to filter on specific project retrospective fields.
- Arrange the portlets on the page so that content is evenly distributed.

**Follow these steps:**

1. Open Administration, and from Studio, click Portlet Pages.
2. Click the name of the portlet page you want to configure.
3. Click Content.
4. Click Add.
5. Select the portlets that you want to add and click Add.
   The portlets appear in the content list.
6. Click Save and Continue.
   The Page Filters tab activates, and the list of page filters appears.
7. Click Add.
8. Select the appropriate filter for the page and click Add.
   The filter is added to the list of filters.
9. Click Save and Continue.
   The Layout tab activates, and the layout page appears. Any content portlets and filter portlets you selected are listed in the layout columns.
10. Place the portlets in the columns that you want them by selecting and moving them to the appropriate columns.
   You can change the column layout using the Layout field at the top of the page.
11. When the layout is complete, click Save and Return to leave the portlet page.
Set Up Link Parameters for the Portlet Page

If you want users to be able to link to the portlet page, assign a link parameter that users can see in a selection list.

Set up link parameters so users can link to the portlet page from another page in the product. For example, if you create a resource status portlet page, you can create a link to that portlet page from the project team staff page.

Follow these steps:
1. Open Administration, and from Studio, click Portlet Pages. The portlet pages list page appears.
2. Click the name of the portlet page.
3. Click Link Parameters.
4. Click New and complete the requested information.
5. Click Save and Return.

Assign User Access to the Portlets

Assign access so that users can see the portlets and the content that the portlets display. For example, if you create a portlet to show project data, provide access for users to see the portlet and the project data. You can assign access in the following ways:

- Assign the global access right Portlet - Viewer - All to let users view all portlets in the product.
- Assign the access right to view a specific portlet only.

Note: Users must have access rights to the portlet and to the data that appears in the portlet.

The following procedure explains how to assign individual users access to a specific portlet. You can also assign access by group or OBS unit.

Note: For more information about assigning access by group or OBS unit, see the Administration Guide.

Follow these steps:
1. Open Administration, and from Studio, click Portlets.
2. Click the name of the portlet.
3. Open the Access to this Portlet menu and click Resource.
4. Click Add.
   The first step of a two-step process appears.

5. Select *Portlet - View* and click Add and Continue.
   If you want users to be able to edit the portlet, select all access rights.
   The second step of the two-step process appears.

6. Select the names of the users to whom you want to assign access and click Add.
   If you have a long list of users to add, click Add and Select More.

7. Click Return when you are done.

### Assign User Access to the Portlet Page

Assign access to the portlet page so that users can see the portlet page containing the tabs and portlets. For example, if you assign access, the user can see a link to the portlet page in menus. The user can also open the page and can view the page contents. You can assign access in the following ways:

- Assign the global access right *Page - Viewer - All* to let users view all pages in the product.
- Assign instance-level access right to view a specific page only.

**Note:** Users must have access rights to the data and the portlet page.

The following procedure explains how to assign individual users access to a specific page. You can also assign access by group or OBS unit.

**Note:** For more information about assigning access by group or OBS unit, see the Administration Guide.

**Follow these steps:**

1. Open Administration, and from Studio, click Portlet Pages.
2. Click the name of the portlet page.
3. Open the Access to this Page menu and click Resource.
4. Click Add.
   The first step of a two-step process appears.
5. Select *Page - View* and click Add and Continue.
   If you want users to be able to edit the page, select all access rights.
   The second step of the two-step process appears.
6. Select the names of the users to whom you want to assign access and click Add.
   If you have a long list of users to add, click Add and Select More.
7. Click Return when you are done.

Add Portlet Page to Menu Manager and Verify

Add the portlet page to the menu manager so users can access it using the Home or Administration menu. For example, if you created a portlet page named Project Retrospective, add the portlet page to the Home menu under the Portfolio Management parent menu.

Follow these steps:

1. Open Administration, and from Studio, click Menu Manager.
2. Click the name of the menu you want to edit.
   The menu hierarchy appears.
3. Click Add.
4. Select Page Link and click Next.
5. Complete the requested information. The following fields require explanation:

   **Link Name**
   Defines the label for the page link that appears in the menu.

   **Page Name**
   Specifies the page that appears when the link is clicked.

   **Parent Menu Item**
   Specifies the menu section in which the link appears.

6. Click Save and Return.
7. Open Home, and click the link name under the parent menu item you specified. For example, click Retrospective from Portfolio Management.
   **Note**: If you do not see your changes reflected in the menu, click Refresh.
8. Verify that the portlet page that appears includes the appropriate portlets with the correct configurations.

After you add the portlet page to the menu manager and verify the page and portlets, you have successfully created the portlet page.
How to Create a User Group

User groups are two or more resources (users) that can share access rights. CA Clarity PPM provides a default user group, called Basic, that gives basic access rights to all users. As a system administrator, you can create additional user groups that have specific access rights for different parts of the product. When you assign a user to a user group, the user is automatically granted the group access rights. You can add an unlimited number of users to a user group.

For example, a user group named Portfolio - Managers provides the following global rights to its assigned users.

- **Portfolio - Create**
- **Portfolio - Edit - All**

These rights allow the portfolio managers create and read/write privileges for all portfolios.

The following diagram describes how a system administrator creates a user group:

![Diagram showing the process of creating a user group]

1. **System Administrator** reviews the prerequisites.
2. **Create a User Group**.
3. Add users to the group.
4. Assign access rights to the group.
   - Assign instance-level access rights to a group.
   - Assign global access rights to a group.
Perform these steps to create a user group:

1. Review the Prerequisites (see page 81)
2. Create a user group. (see page 81)
3. Add users to a user group. (see page 81)
4. Assign access rights to a user group. (see page 82)
   - Assign instance-level access rights to a user group. (see page 83)
   - Assign global access rights to a user group. (see page 84)

Review the Prerequisites

Verify the following prerequisites to help ensure that you can successfully create a user group:

- Resources exist to add users to the user group.
- Studio Objects exist to assign instance-level access rights.

Create a User Group

Create a user group to provide access rights that two or more users can share.

For example, create a user group named Portfolio - Managers so that all portfolio managers share access rights to portfolios.

Follow these steps:

1. Open Administration, and from Organization and Access, click Groups.
   
   The group list appears.

2. Click New and enter the information for the new user group.

3. Save your changes.

   The updated Groups list page appears. You can now add users to the user group.

Add Users to a User Group

Add users to a user group so they share access rights and can perform similar tasks. For example, you can add all users who are portfolio managers to a user group named Portfolio - Managers so that they have the same rights and can perform similar tasks with portfolios.
Follow these steps:

1. Open Administration, and from Organization and Access, click Groups.
2. Open a group and click Resources.
3. Click Add.
4. Select the users to add to the user group and click Add.
   The users are added to the user group.
5. Choose one of the following options:
   a. Click Continue to add access rights to the user group.
   b. Click Return to go to the list of user groups.

Assign Access Rights to a User Group

Access rights provide users read/write privileges for features and functions. For example, assign portfolio managers Portlet - View instance rights so they can access the portfolio pages. Assign Portfolio - Edit- All global rights so they can edit all portfolios.

For information about specific access rights, see the CA Clarity PPM Access Rights Reference.

You can assign access rights to a user group at the following levels:

**Instance**

Provides access to object instances (for example, a specific portfolio, rather than all portfolios).

**Organization Breakdown Structure (OBS) Unit**

(Not typical for user groups.) Provides access rights to all instances having the selected OBS unit.

**Global**

Provides unlimited access to an object (for example, all portfolios rather than a specific portfolio).
Assign Instance-Level Access Rights to a User Group

Assign instance-level access rights to provide access to specific object instances. For example, assign portfolio managers instance-level access to the Portfolio portlet pages so they can work with portfolios.

Follow these steps:

1. Open Administration, and from Organization and Access, click Groups.
2. Open a group and click Group's Access Rights.
3. Click Instance.
   A list of instance-level access rights for the user group appears. If the user group is new, no access rights appear.
4. Click Add.
5. Select an object from the Object drop-down list and click Next.
   A list of access rights for the selected object appears.
6. Select the access rights to add to the user group and click Add and Continue.
   Note: If more access rights are available on additional pages, select the access rights and click Add and Select More. Continue assigning access rights until all appropriate access rights have been assigned.
   A list of instances for the selected object appears.
7. Select the instances that you want by clicking the corresponding check boxes and click Add.
   Note: If more instances are available on additional pages, select the instances and click Add and Select More. Continue assigning instances until all appropriate instances have been added.
8. When you have finished assigning instance level access rights to the user group, choose one of the following options:
   - Click Continue to add global access rights, if the user group needs access rights for all instances of an object.
   - Click Return to go back to the Groups page.
   After you assign instance-level access rights to a user group, you have successfully created a user group with access rights. The users in the user group can now perform their assigned tasks.
Assign Global Access Rights to a User Group

Assign global access rights for all instances of an object to system administrators or super users so they can perform both end-user and administrative functions.

For example, assign a user group, called Portfolio - Managers, global access rights to the Portfolios object. With this access, group members can create, edit, or remove portfolios.

Follow these steps:

1. Open Administration, and from Organization and Access, click Groups.
2. Open a group and click Group's Access Rights.
3. Click Global.
   A list of global access rights for the user group appears. If the user group is new, no access rights appear.
4. Click Add.
5. Select the appropriate global rights for the user group and click Add.
   **Note:** If more access rights are available on additional pages, click Add and Select More. Continue assigning access rights until all appropriate access rights have been assigned.
6. When you have finished assigning global rights to the user group, click Return.
   The Groups list page appears.

After you assign global access rights to a user group, you have successfully created a user group with access rights. The users in the user group can now perform their assigned tasks.
How to Customize the Actions Menu

The Actions menu appears on the list and properties views of most pages. This menu provides quick access to actions that a user can take directly from the page.

You can modify the list of options that appears by default under the General submenu, or you can create additional submenus with options.

The Actions menu is specific to an object. The menu options are actions that you can perform on the object. The menu is controlled from the properties and list views of the object. For example, to add options to the Actions menu for projects, you complete the following tasks:

- Create the options for the Project object in Studio
- Add the options to the Projects list view and properties view

The following illustration shows the default Actions menu for a project properties page.
How to Customize the Actions Menu

The following diagram describes how an administrator customizes the Actions menu.

The following diagram describes how an administrator customizes the Actions menu.

Perform these steps to customize the Actions menu:

1. Review the prerequisites (see page 87).
2. Create a report option (see page 87).
3. Create a job option (see page 89).
4. Create a process option (see page 90).
5. Create an internal link option (see page 91).
6. Create an external link option (see page 92).
7. Add options to the Actions menu:
Chapter 3: System Administrator Scenarios

8. Test the updates to the Actions menu (see page 95).

Review the Prerequisites

To customize the Actions menu, you need the Administration - Studio access right.

Before you start customizing the Actions menu, determine the following information:

- Which tasks or locations does a user need access to from the page?
- What is the next logical location in the product that a user needs after completing tasks on the page?
- Have you provided the ability at an internal link destination to return to the source page?
- Have you verified that users have the appropriate access rights to use options that you create? For example, if you provide a link to a page, a user must have rights to see the page.

Consider the following information as you plan how to customize options and submenus:

- When you place an option in a submenu within the Actions menu, it is immediately visible to users, even users with personalized views.
- The following page types do not have an Actions menu available:
  - Pages that do not have a view.
  - Pages that have one or more portlets (for example, dashboards).
  - Pages that combine a view and portlets.
- An option can be placed in a submenu on the Actions menu on any page that corresponds to a view in the object definition.

Create a Report Option

Create a report option to let a user run a report automatically from the Actions menu. The report displays in a pop-up page. For example, if you add a report option to run the Customer Invoice report, a user can run the report from the menu without leaving the page. Without the option, the user is required to go to the Reports and Jobs option in the Home menu, open the report page, and start the report from that location.

You provide report parameters when you create the option by mapping the parameters to value attributes on the specific object instance.
The following prerequisites are required for a report option:

- A user must have access rights to the report definition to run a report.
- You can only map report parameters to value attributes inside the partition to which the object view belongs.
- The report must be active.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Open the object and click Actions.
3. Click New.
4. Complete the requested information. The following fields require explanation:
   
   **Type**
   
   Specifies the type of action.
   
   Select Report.

   **Scope**

   Specifies whether an action is global or limited to a specific instance.

   **Values:**

   - Global—Allows the user to run the action without having to select a specific instance. This option also makes the action available to be added to any view within any object and to the Home menu.
   - Instance-specific—Allows the user to select a specific instance before running the action. In addition, the action can be performed from within a specific instance. You can add an instance-specific action only to the views for the object under which the action was created. Instance-specific actions cannot be added to the Home menu.

5. Complete the following fields in the Attribute Mapping section:

   **Parameters**

   Displays the parameter fields that appear when you run an instance-specific action. The parameters vary depending on the action.

   **Default Values**

   Displays the global default values that are entered for parameters of an instance-specific action. You can change the default values for the action.
Object Attribute Overrides

Specifies the object attributes that can override the default values for instance-specific actions. Within an Object Attribute Overrides field, map the object attributes only to attributes of the same data type as the Parameter field value.

6. Save your changes.

Create a Job Option

Create a job option to let a user run a job automatically from the Actions menu. For example, if you add a job option for the Update Earned Value Totals job, a user can run the job directly from the menu. Without the option, the user is required to go to the Reports and Jobs option in the Home menu, open the jobs page, and start the job from that location.

You provide job parameters when you create the option by mapping them to value attributes on the object instance.

The following prerequisites are required for a job option:

- A user must have access rights to the job definition to run a job.
- You can only map job parameters to value attributes inside the partition to which the object view belongs.
- The job must be active.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Open the object and click Actions.
3. Click New.
4. Complete the requested information. The following fields require explanation:

   Type
   Specifies the type of action.
   Select Job.

   Select Job
   Specifies the job that is launched from the Actions menu by the user.

   Alert users before running the job
   Specifies whether the user is alerted before the job runs.
How to Customize the Actions Menu

Scope

Specifies whether an action is global or limited to a specific instance.

Values:

■ Global—Allows the user to run the action without having to select a specific instance. This option also makes the action available to be added to any view within any object and to the Home menu.
■ Instance-specific—Allows the user to select a specific instance before running the action. An instance-specific action can only be added to the views for the object under which the action was created. Instance-specific actions cannot be added to the Home menu.

5. Complete the following fields in the Attribute Mapping section:

Parameters

Displays the parameter fields that appear when you run an instance-specific action. The parameters vary depending on the action.

Default Values

Displays the global default values that are entered for parameters of an instance-specific action. You can change the default values for the action.

Object Attribute Overrides

Specifies the object attributes that can override the default values for instance-specific actions. Within an Object Attribute Overrides field, map the object attributes only to attributes of the same data type as the Parameter field value.

6. Save your changes.

Create a Process Option

Set up a process option to let a user start a process from the Actions menu. For example, if you add a process option to the Actions menu for the Idea Approval process, a user can run the process directly from the Actions menu. The option in the Actions menu keeps the user from leaving the page. Without the option, the user is required to go to the Organizer option in the Home menu, open the processes page, and start the process from that location.

The following prerequisites are required for a process option:

■ A user must have access rights to start a process. The option for the process displays in the Action submenu only when the user has access rights to start the process.
■ You can only map process parameters to value attributes inside the partition to which the object view belongs.
■ The process must be active.
How to Customize the Actions Menu

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Open the object and click Actions.
3. Click New.
4. Complete the requested information. The following fields require explanation:
   - **Type**
     - Specifies the type of action.
     - Select Process.
   - **Alert users before running the process**
     - Specifies whether the user is alerted before the process runs. Select the check box to alert the user.
5. (Optional) Complete the field in the Define Primary Object section to run this option outside the primary object view.
   - For example, consider the case where you run an option named Approve Risk (where Risk is the primary object) from the Project object view. To set up the option properly, map to an attribute that belongs to the Project object.
6. Save your changes.

Create an Internal Link Option

Create an internal link option to let a user navigate to a specific page from the current page. For example, you can add an option to a project properties page that links to the Knowledge Store page.

The following prerequisites are required for an internal link option:

- A user must have access rights to view the page to which the link refers. The option for the link displays in the Action submenu only when the user has access rights to the target page.
- The link must exist.

Follow these steps:

1. Open Administration, and from Studio, click Objects.
2. Open the object and click Actions.
3. Click New.
How to Customize the Actions Menu

4. Complete the requested information. The following fields require explanation:

   **Type**
   Specifies the type of action.
   Select Internal Link.

   **Select Link**
   Specifies the page that a user opens from the Actions menu. Select the page from the drop-down list. The list includes all links that are displayed on the Linking tab for the object.

5. Save your changes.

Create an External Link Option

Create an external link to let a user navigate to an external URL outside of the product. The external link object action displays in a pop-up page.

**Follow these steps:**
1. Open Administration, and from Studio, click Objects.
2. Open the object and click Actions.
3. Click New.
4. Complete the requested information. The following fields require explanation:

   **Type**
   Specifies the type of action.
   Select External Link.

   **Scope**
   Specifies whether an action is global or limited to a specific instance.

   **Values:**
   - **Global**—Allows the user to run the action without having to select a specific instance. This option also makes the action available to be added to any view within any object and to the Home menu.
   - **Instance-specific**—Allows the user to select a specific instance before running the action. An instance-specific action can only be added to the views for the object under which the action was created. Instance-specific actions cannot be added to the Home menu.

   **Enter URL**
   Defines the URL that appears on the Actions menu. For example: http://support.ca.com/.
5. If you selected instance-specific for the scope, complete the following fields in the Define URL Arguments section:

**Number of Arguments**

Specifies the number of arguments (name+value pairs) to be included as parameters. Select a number to indicate how many name+value pairs that you want to include. The name+value pairs are appended to the end of the URL. Name+value pairs are separated by an ampersand (&). The values are URL-encoded when they are appended to the URL.

**Argument #**

Indicates the name in the name+value pair that is used as a parameter for an external link option. Enter a name.

**Argument # - Value**

Indicates the value in the name+value pair that is used as a parameter for an external link option. Select an option to indicate whether the value is a constant or an instance-specific value, and provide the value. Select an object attribute for the instance-specific value. The attributes listed in the drop-down list are associated with the object on which the option is being created.

6. Save your changes.

### Create a Submenu

Create submenus on the Actions menu to group menu options. For example, if you have multiple reports to add as options, you can create a submenu named Reports. Placing the report options together under one submenu makes them easier to find.

Active options and global options that are defined within any object are available for addition to a submenu in an object list or properties view.

**Note:** If you want a submenu to appear on the list and the properties view, create a menu for each view.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Open the object and click Views.
3. Click Actions Menu in the Setup Column of the appropriate view.
4. Click New.
5. Complete the requested information for the menu name, menu code, and description.

6. Move the appropriate menu options to the Selected Actions list box.
   
   **Note:** Use the arrows to place the menu options into the correct order in the Selected Actions list box.

7. Click Save and Return.
   
   The new menu is created and appears in the Actions menu list for the view.

8. Click Menu Layout.
   
   The list of submenus appears in the order that appears on the Actions menu for the view.

9. Move the submenus into the appropriate order using the arrows.

10. Save your changes.

**Update Existing Submenus**

Update existing submenus to add or remove options. For example, you can add options to the default General submenu.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.

2. Open the object and click Views.

3. Click Actions Menu in the Setup Column of the appropriate view.
   
   The actions submenu menu list appears.

4. Click the name of the menu you want to update.

5. Update the submenu by moving the appropriate options into the Selected Actions list box.

6. Save your changes.
Test the Updates to the Actions Menu

Navigate to the page that contains the updated Actions menu and verify the following points:

- Menu options display and launch correctly.
  - For missing options, verify that you have the appropriate rights to perform the menu option. For example, the access right to work with processes is required for an option for processes to display.
  - For an option that does not launch correctly, verify the properties for the option.
  - For a job, report, or process option that does not work, verify the parameter settings by opening the option.
  - For an external link that does not work, verify the URL.
  - For an internal link that does not work, verify the link settings.

- Submenus display correctly.
  - For a missing submenu, verify that you placed the submenu on the correct view.
  - If a submenu is not in the correct place, repeat the procedure to determine the submenu location on the Actions menu.

When updates to submenus or options display and start properly, you have successfully customized the Actions menu.

How to Manage Authentication

Managing authentication is an important part of ensuring that unauthorized users do not gain access to system resources or sensitive information. Use the following settings to configure session and password options for all users, and to manage authentication for individual users.

Authentication Settings

Limits the number of invalid login attempts and specifies how long user sessions can be inactive before logging out users. For example, you can set a value of 3 for the number of times a user can enter an invalid login. You can also set the minutes of inactivity to 30.

User Login Status

Specifies the status of one or more users as Active, Inactive, or Lock. For example, a user takes a leave of absence. You can set the status to inactive so that they cannot log in and administrators do not assign the user to projects.
**Password Options**

Specifies how often users change their passwords, the rules for password length and character combinations, and how frequently a password can be reused. For example, you can specify users can reuse a password after three other unique passwords.

You can also manage the resetting of passwords at an individual or system-wide level.

In this scenario, the term *user* and *resource* are used to describe similar concepts. A user refers to a person that logs in to the product and manipulates the user interface. A resource represents a user for whom you manage authentication. The resource can be added to projects and teams.

For example, a user named Judit logs in weekly to fill in her time sheet. Judit forgets her password and requests a reset. You reset it by updating the resource that is named Judit and contains her password information.

The following diagram describes how a system administrator configures and then manages authentication.
Perform these steps to manage authentication:

1. **Review the prerequisites** (see page 97).

2. Complete the following tasks:
   - Configure authentication settings:
     a. **Configure general session limits** (see page 97).
     b. **Configure general password options** (see page 98).
   - **Manage user login status** (see page 99).
   - Manage user passwords:
     - **Reset a user password** (see page 100).
     - **Force a user to reset a password** (see page 101).
     - **Force all users to reset passwords** (see page 101).

### Review the Prerequisites

To complete all tasks in this scenario, consider the following items:

- Create one or more resources.
- Have the following access rights:
  - Administration - Access
  - Administration - Application Setup
  - Administration - Authorization
  - Administration - Resources
  - Resource- Edit Administration
- Ensure that users set their web browser to accept cookies for session tracking.

### Configure General Session Limits

Specify limits for all user sessions to prevent access by unauthorized users. For example, define how many times a user can enter an invalid password before being locked out.

**Follow these steps:**

1. Open Administration, and from General Settings, click System Options.
2. In the Session Options section, complete the following fields:

**Invalid Login Limit**
Defines the maximum number of consecutive login attempts before changing the status of a user to Lock. Enter a number higher than 0 to enable this option.

- **Limits:** 0-99
- **Default:** 0 (Disabled)

**Minutes Of Inactivity Until Logout**
Defines the idle minutes before changing the status of a user to Lock. Enter 0 to disable the option.

- **Limits:** 0 - 999
- **Default:** 60 (Enabled)

3. Save your changes.

### Configure General Password Options

Configure password options to help ensure that unauthorized users cannot easily identify passwords. For example, you can set a rule that passwords have at least eight characters with at least has one capital letter and one numeric value.

**Follow these steps:**

1. Open Administration, and from General Settings, click System Options.
2. In the Change Password Options section, complete the requested information.

The following fields require explanation:

**Password Rules**

Specifies two options: a simple password character limit or a custom expression that specifies upper and lowercase characters and numeric values.

**Minimum Password Length (characters)**

Defines the minimum number of characters a password can contain. If you change the setting, the product prompts users to change their passwords if they violate the new rule.

- **Limits:** 0-99

**Define Custom Expression**

Allows you to define an expression for a password. Select to enable the Regular Expression and the Error Message fields.
Regular Expression

Defines one or more of the following expressions to specify acceptable characters for the password:

**Values:**
- ^ — Indicates the beginning of the expression.
- (?=.*[a-z]) — Any lowercase alphanumeric characters are allowed.
- (?=.*[A-Z]) — Any uppercase alphanumeric characters are allowed.
- (?=.*[^!@#$%^&*()-+=]) — Any special characters are allowed.
- .{n,n1}$ — The required password length, where n indicates the minimum number of characters that are required and n1 the maximum. To indicate only the minimum length, omit the maximum number. To indicate only the maximum length, omit the minimum number. For example, enter .(8,)$ to specify a minimum eight-character password.
- $ — Indicates the end of the expression.

**Example:** Set a rule that specifies a password can include any lower- or uppercase alphanumeric or special characters, and must be between 8-16 characters in length.

```
^ (?=.*[a-z]) (?=.*[A-Z]) (?=.*[^!@#$%^&*()-+=]) .{8,16}$
```

**Error Message**

Defines the message to display to users who do not enter properly formatted passwords.

**Example:** "Invalid password; enter a valid password that has at least eight characters, one uppercase letter, and one number."

3. If all users must change their passwords, click Force Password.
   The product forces all users to change their password during the next login.

4. Save your changes.

**Manage User Login Status**

Use the resource Status property to specify whether a user can log in and can have access to the product. When you activate users, project or resource managers can add them as resources to projects.
When you deactivate users, they can no longer log in. Additionally, project or resources managers cannot add them as resources to a project. The product retains all information about the inactive users and you can reactivate the users later.

Users can also have the status of Lock. For example, if a user makes too many invalid login attempts, the status changes to lock. You can change the login status back to active.

You can change access for one or more users at a time.

**Note:** If LDAP is running, you can change the status of only one user at a time. For more information about authentication and LDAP, see the *Installation Guide* or contact your LDAP administrator.

**Follow these steps:**
1. Open Administration, and from Organization and Access, click Resources.
2. Select one or more resources and click one of the following buttons:
   - **Activate:** activates one or more users so that they can be added to projects.
   - **Deactivate:** deactivates one or more users, prevents them from logging in, and prevents project or managers from adding them as resources to projects.
   - **Lock:** locks one or more users and prevents them from logging in.
3. Save your changes.

**Reset a User Password**

Reset a user password when the user has lost or compromised their password. For example, if a user forgets the password, you can provide a temporary password and can force the user to change it during the next login.

**Note:** If you use LDAP to manage authentication, use LDAP to manage password resets. For more information about authentication and LDAP, see the *Installation Guide* or contact your LDAP administrator.

**Follow these steps:**
1. Open Administration, and from Organization and Access, click Resources.
2. Open the resource.
3. Complete the requested information.
4. (Optional). Select Force Password Change to ensure that the user resets the temporary password during the next login.
5. Save your changes.
6. Send the temporary password to the user.
   The user can use the temporary password to log in. If you select Force Password Change, the user must immediately reset the password.

**Force a User to Reset a Password**

Force a user to reset a password when they have forgotten the password or the password has become compromised.

For example, a user becomes locked out of the product and you reactivate them. You can then force the user to reset the password during the next login.

**Note:** If you use LDAP to manage authentication, use LDAP to manage password resets. For more information about authentication and LDAP, see the *Installation Guide* or contact your LDAP administrator.

**Follow these steps:**
1. Open Administration, and from Organization and Access, click Resources.
2. Open the resource.
4. Save your changes.
   During the next login, the user must reset their password.

**Force All Users to Reset Passwords**

Use the Force Password setting to make all users reset their passwords the next time they log in. For example, as part of a security policy change, you increase the password character length from six to eight characters. After the change, you can force all users to change their passwords to meet the new requirement.

**Follow these steps:**
1. Open Administration, and from General Settings, click System Options.
2. In the Change Password Options section, click Force Password Change.
3. Save your changes.

You have now learned how to configure authentication options and to manage user password settings.

How to Set Up Partitions

Use partitions to create different views of the same objects for different users. Not every user uses every page or field in the product. You can simplify the user interface by defining what can be viewed in a partition and giving a user or a group of users access to the partition. You can set up partitions by department, geography, industry, division, legal structure, or any other method that your enterprise requires.

This explanation of partitions assumes the items that you want to include in the partition (for example, objects or attributes) exist. This explanation does not explain how to create items to include in the partitions.

**Note:** Partitions are an optional way to manage and extend the presentation of information. They are not required as part of the product setup.

A *partition model* is the top node (parent) of a partition hierarchy. All partition models belong to the System partition, the default product partition. You can create a partition model to fit any structure that your enterprise needs. You can add as many partitions as necessary to a partition model. You can also add partitions to partitions so that you can create a multilevel hierarchy if necessary. Each partition can contain its own version of information that is specific for its environment.
Example: A Partition Model

The following illustration shows a simple partition model. In the illustration, an administrator creates a partition model named Forward, Inc. with children partitions named U.S. and Europe. The Europe partition has additional children partitions for the Paris and London offices of the enterprise. The Paris, London, and U.S. partitions contain Project object attributes that are specific to those office locations. In this case, the administrator creates and adds custom attributes to the project object and assigns them only to the appropriate partition (U.S., Paris, or London). In this way, the functionality and other aspects of the Project object are shared across all users with the appropriate access rights. However, specific view settings for the Paris, London, or U.S. locations are available only to users who are assigned access to those partitions.
The following diagram describes how an administrator sets up partitions.

How to Set Up Partitions

1. Plan the Implementation
2. Create a Partition Model and Add Partitions
3. Define What Displays in the Partitions
   - Associate Objects with a Partition
   - Include Object Links in a Partition
   - Include Attributes in a Partition
   - Define Static Lookup Values for a Partition
   - Modify Views for a Partition
   - Select a UI Theme for a Partition
4. Test the Partitions in the Product
5. Assign User Access to Partitions
   - Complete
Perform these steps to set up partitions:

1. **Plan the implementation** (see page 105).
2. **Create a partition model and add partitions** (see page 106).
3. Define what displays in the partitions.
   - **Associate objects with a partition** (see page 107).
   - **Include attributes in a partition** (see page 107).
   - **Modify views for a partition** (see page 108).
   - **Include object links in a partition** (see page 109).
   - **Define static lookup values for a partition** (see page 109).
   - **Select a UI theme for a partition** (see page 110).
4. **Test the partitions in the product** (see page 110).
5. **Assign user access to partitions** (see page 111).

**Note:** You do not need to restart the product to enable partitioning; all partitioning configuration changes are immediately available. You can also export partition models and other items created in connection with partitioning from the product using the XML Open Gateway (XOG). When you export a partition model, only the partition model and its partitions are exported. Any objects or other settings that are associated with the partition are not exported.

---

**Plan the Implementation**

To work with partition models and partitions, you need the following access rights:

- Administration - Studio
- Administration - Partition Models

Before you start setting up partitions, determine the following information:

- The number of partitions needed
- The hierarchical structure of the partitions
- What to include in each partition
- Users for each partition

As you plan, consider the following rules for working with partition models and partitions:

- You can set up multiple partition models.
- You cannot delete a partition model; however, you can deactivate it.
- An object can be assigned to only one partition model at a time.
When you include a partition in a partition model, its location in the hierarchy is fixed. You cannot move the partition.

A child partition can inherit what can be viewed in its parent, depending on the association mode selected. If the child partition has been modified, changes to the parent partition are not applied to the child partition.

When an object is assigned to a partition model, its associations (for example, attributes, views, or links) are visible to all partitions in the partition model by default.

A user who is not a member of any partition sees the default System partition views.

A user with Studio access rights can be a member of more than one partition within a partition model. However, when the user creates an object, the user selects the partition to use. For example, a user can be a member of the U.S. and European partitions, but the user selects one partition to use when creating a project.

Users can be assigned only one partition and therefore do not need to select a partition.

Create a Partition Model and Add Partitions

Create a partition model and add a partition for each different presentation of the user interface your enterprise requires.

Follow these steps:

1. Open Administration, and from Studio, click Partition Models.
   
   The partitions models list page appears.

2. Click New and specify the required information.

3. Click Save and Continue.
   
   The Partitions tab is activated. You can add partitions to the new partition model.

4. Click New.

   Note: To add multiple partitions to the new partition model at the same time, click Quick Create.

5. Enter the information for the new partition.

   The following fields require explanation:

   **Parent Partition**

   Specifies the position of the new partition in the hierarchy by identifying the parent partition.
UI Themes

Specifies the color theme for the partition user interface.

6. Save your changes.

Associate Objects with a Partition

The Standard partition contains default objects that are associated with all partitions through inheritance. This procedure explains how to associate a custom object with a partition.

You do not have to be a member of a partition to perform this task. An object can be associated with only one partition model.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object to which you want to apply a partition model.
   The properties page appears.
3. Select a partition model.
4. Save your changes.

Include Attributes in a Partition

Create attributes to collect specific information. For example, the London office of an enterprise has different project requirements than the Paris office. The administrator creates attributes for the project object that are specific to the London office and includes them in the London partition. Only the users who are included in the London partition see the attributes.

You can change the partition assignment or partition mode of an attribute at any time. Carefully consider the impact that changes can have on items that reference an attribute. For example, a grid portlet using a user-defined date attribute for Gantt chart columns does not display if the required date attribute becomes absent. A process instance can fail if it can no longer evaluate or set an attribute.

Follow these steps:
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object whose attribute you want to add to a partition.
3. Click Attributes to display the object attributes.
4. Click the attribute that you want to assign to a partition.
5. Complete the following fields:

**Partition**
Specifies the partition to associate with the attribute.

**Partition Association Mode**
Specifies which partitions can include the attribute, in addition to the selected partition.

6. Save your changes.

**Modify Views for a Partition**

Views determine how information displays in the product for a specific object. You can determine the attributes that display for the object and the arrangement of attributes on the page. Each object has the following default views:

**Properties**
Lets a user enter information for an object instance. For example, the properties view for the project object lets a user enter information for a specific project.

**List Column**
Displays the instances of an object in rows and columns.

**List Filter**
Lets a user search for information about the list column page.

If a partition does not have views for an object, the partition inherits the object views of the nearest ancestor partition. If no ancestor partitions have views for the object, the partition uses the System partition views.

**Best Practice:** Define partitioned views for objects at the top of the partition model first. For example, if you are using a geographical partition model with *World* at the top and *United States* and *Europe* as children partitions, define the *World* views first.

**Follow these steps:**

1. Open Administration, and from Studio, click Objects.
2. Click the name of the object whose views you want to modify for a partition.
3. In the object properties, verify that a partition model is assigned to the object.
   
   If a partition model is not assigned, assign the correct partition model to the object.
4. Click Views.
   
   The list of views for the object appears.
5. In the Partition field above the list, select the partition to which the view modifications apply.
6. Use the view links to modify the layout of the object for the selected partition.

**Include Object Links in a Partition**

Include object links in a partition to provide shortcuts to subpages of the object page or to external web pages.

**Follow these steps:**
1. Open Administration, and from Studio, click Objects.
2. Click the name of the object whose link you want to add to a partition.
3. Click Linking.
4. Click the link that you want to assign to a partition.
5. Complete the following fields:
   - **Partition**
     - Specifies the partition to be associated with the object link.
   - **Partition Association Mode**
     - Specifies which partitions can include the object link other than the selected partition.
6. Save your changes.

**Define Static Lookup Values for a Partition**

You can partition static lookup values. Users of a partitioned lookup see different values in the lookup, depending on the partition to which an object instance belongs.

Partitioned lookups allow you to enforce standard options throughout an entire branch of a partition model. You can also add lookup values to meet the unique requirements of a business unit partition.

You can add partitioned values to default static lookups or to user-defined static lookups. If an object instance is not partitioned, the lookup shows only values for the System partition. You can assign a lookup to a partition when you create it, or you can modify an existing lookup and then assign it to a partition.

**Follow these steps:**
1. Open Administration, and from Data Administration, click Lookups.
2. Click the name of the static lookup whose values you want to add to a partition.
   - The properties for the static lookup appear.
3. Click Values to see the values that are assigned to the lookup.
4. Click the name of the value that you want to assign to a partition.
5. Complete the following fields:
   - **Partition**
     Defines the partition for a lookup value.
   - **Partition Association Mode**
     Specifies which partitions can include the lookup value other than the selected partition.
6. Save your changes.

**Select a UI Theme for a Partition**

UI themes vary the look of the user interface. Several default UI themes are available that allow you to change the colors used in the user interface, log in information, branding, and other aspects that users see. Custom UI themes can customize the logo, the application name, tabs, buttons, icons and other features.

When creating a partition, you can select a UI theme or you can accept the default theme. This procedure explains how to select a UI theme after a partition is created.

**Follow these steps:**
1. Open Administration, and from Studio, click Partition Models.
2. Click the name of the partition model.
3. Click Partitions.
4. Click the name of the partition for which you want to set the UI theme.
5. Select a UI theme.
6. Save your changes.

**Test the Partitions in the Product**

When a partition is complete, test it in the product user interface. Testing verifies that all of the information that you want presented in the partitions is available.

**Follow these steps:**
1. Create a test user with the appropriate access rights and assign the user to the partition.
2. Log out as a user with Studio access rights and log in to the product as the test user.
3. Verify that the modifications that you made to the partition are available. Complete this procedure for each partition you create.

**Assign User Access to Partitions**

Access rights determine what information users can see and the functions they can perform. The administrator can grant access rights to users (resources), groups, OBS units, or globally to all users. Partitioning affects what objects are exposed to users. Therefore, partitioning and access rights work together.

If a user has access rights to an instance of a partitioned object, the user can see partitioned views of the instance. The user can see the instance even if the user is not a member of the partition to which the object instance belongs.

Partitioning affects user ability to do the following tasks:
- Create partitioned attributes.
- Change the layout and appearance of attributes for partitioned objects.
- Assign an object instance to a partition.
- Select a default partition.
- Switch partition views.
- See and personalize partitioned List Column and List Filter views.
- Create or see partitioned values for lookups.

**Follow these steps:**
1. Open Administration, and from Studio, click Partition Models.
2. Click the name of a partition model.
3. Click Partitions. The list of partitions appears.
   **Note:** Click the + icon next to a partition to see child partitions.
4. In the row that contains the partition you want, click the Properties icon.
5. To assign an individual user (resource), a group, or an OBS unit access to the partition, complete the following steps:
   a. Open the Partition Members menu and click one of the following menu options: Resources, Groups, or OBS Units.
   b. Click Add.
c. Select the appropriate check boxes and click Add.
   If you have more selections than appear on a single selection page, use Add
   and Select More.

6. After you add all selections, click Return.

   After you assign user access to partitions, the setup of partitions is complete.